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1 Software Overview 

1.1 About Voxeldance Additive 

Voxeldance Additive is a data preparation software for Additive Manufacturing, 3D printing, 

prepare and optimize the parts quickly and easily, ensure to print high quality parts. To prepare 

for printing, it converts three-dimensional files into two-dimensional slice files, consisting of a list 

of two-dimensional slice layers for printing. It can view, edit, repair and analyze three 

dimensional files in several formats. 

Voxeldance Additive mainly provides the following functions: Part import, file repair, smart 

2D/3D placement, part editing, support generation, slicing and so on. 

1.2 System Requirements 

1.2.1 Hardware 

CPU 

• Intel Core i5/i7/i9 

• AMD Phenom II X4/X6 at 3.0GHZ or higher with SSE2  

Memory 

• 16GB RAM or higher  

Free Disk Space 

• 2GB of free disk space  

Display 

• 11920 x 1080 resolution or higher 

• 2560 x 1440 is recommend 

Video Card 

• NVIDIA Geforce GTX 1060 or AMD Radeon RX 480 or better 
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• At least 1GB of memory 

• At least a memory interface width of 192-bit (256-bit is recommended) 

• Any Intel GPU chipsets is not recommended 

1.2.2 Operation System 

Voxeldance Additive is only supported on: 

• Windows 10 (64 bit) (recommended) 

• Windows 8 / 8.1 (64 bit) 

• Windows 7 (64 bit) 

Voxeldance Additive is recommended： 

• Windows Professional edition 

• Windows Enterprise edition 

Voxeldance Additive is not supported on following system： 

• Windows Server edition 

• Virtualization system such as VMWare 
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2 Program Overview 

The user interface of this program consists of a graphic display window, a menu bar, a toolbar, 

and a part view window, as shown in Figure 2.1. 

The graphic display window consists of a platform and a ruler, occupying most of the space of 

the interface. 

The Part Navigator displays a list of parts or a list of slices as a tree list. The Details and the Clipping 

are used to display the basic data information of the part and control the internal observation of 

the cutting section, respectively. Click the icon  on the right of the menu bar is to switch the 

display status of the menu bar. 

The functions and operations can be found in the menu bar, toolbar, right-click menu or through 

shortcut keys. 

 

Figure 2.1 Voxeldance Additive Standard Interface 
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2.1 Part List 

The Part Navigator displays all parts on each platform in a tree-like directory structure, as shown in 

Figure 2.2. Select the part by checking the check box in front of the part. You can also select 

multiple parts at the same time by using the Shift or Ctrl key, and then check in front of any part to 

select multiple parts. 

 

Figure 2.2 Part View window 

Double-click the circular icon " " on the right side of the part to change the color of the part; 

click the eye icon " " on the left side of the part to control the part to be shown or hidden. 

Double-click the icon " " under the Quality to check the quality of the part. 

In addition, by right-clicking each item in the directory, you can find the corresponding 

functions and operations in the right-click menu. For example, you can rename part through the 

right-click menu or double-click the part name; you can create a group through the right-click 
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menu, and add one or more parts to the group by dragging and dropping, which is convenient 

for unified management and operation, especially for multiple parts . 

You can add multiple platforms in the Parts Navigator, and you can drag one or more parts from 

one platform to another platform with the left mouse button. In addition, you can choose to 

display all platforms or only the current platform through the tree option in the right-click 

menu, as shown in Figure 2.3. 

 

Figure 2.3 Platform display options 

2.2 Graphic Display 

The graphic display window provides a three-dimensional visual representation of the platform 

and the parts. A platform is a three-dimensional display area that represents the actual 

machine print space with the borders. The coordinate system in the upper right corner of the 

display window is used to indicate the current viewing angle. 

The graphic view can be adjusted by mouse operation. By holding down the right button and 

moving the mouse, you can rotate the viewing angle; by holding down the scroll button and 

moving the mouse, you can move the platform and parts without changing the angle of view; 

by sliding the scroll wheel, you can control the zooming of platforms and parts. 

By selecting and dragging a part, you can move or rotate the part without changing the position 

and orientation of the platform and other parts. After selecting a part, left-click and hold the 

square icon in its center position and move the mouse to change the position of the part, as 

shown in Figure 2.4. 
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Figure 2.4 Select part to move or rotate by mouse 

2.3 Software Functions 

Apart from the basic operations in the above-mentioned display window, most of the 

remaining functions of the software can be realized through the following ways. 

Firstly, right-click the part name in the part list, the part in the display window, or the blank 

area in the display window, the corresponding context menu will be displayed with available 

functions and actions, as shown in Figure 2.5. 

Secondly, the toolbar at the bottom of the display window provides various available functions 

and operations according to the current interface or function module. 

The following sections will introduce the function modules in the File, Home, Modify, Support 

Generation, Analysis, and View menus in later chapters. 
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Figure 2.5 The right-click menu of part (left) and blank area (right) 

In addition, some functions and features associated with each module will be presented in the 

context window located in the lower right part of the interface. The Details page shows the 

information of the selected part. The Clipping page provides multi-section cutting to observe 

the internal structure of the part, as shown in Figure 2.6. 

    

Figure 2.6 Basic information page 

2.4 All Shortcut keys 

Voxeldance Additive can be controlled with shortcut keys. See the following table for an 

overview: 

Operation Shortcut key Operation Shortcut key 

New Project Ctrl + N Display Mode Ctrl + G 

Open Ctrl + O Zoom in A 

Save Project Ctrl + S Zoom out Q 

Cut Ctrl + X Zoom to All Parts F2 

Copy Ctrl + C Zoom to Selected Parts F3 

Paste Ctrl + V Zoom to Platform F4 

Undo Ctrl + Z Panning Ctrl + M 

Redo Ctrl + Y Perspective Space 
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Select All Parts Ctrl + A View Right G 

Highlight Selected Parts H View Front V 

Switch 

Selected/Unselected 
Ctrl + I View Bottom B 

Hide Selected Parts Ctrl + H View Top V 

Find a command Ctrl + Q View ISO F 

Create Platform Ctrl + W Wall Thickness Shift + W 

Platform Definitions Ctrl + P Volume Estimation F12 

Create Part Shift + N 
Move selected parts in 

positive X direction 
Shift + Right 

Move T 
Move selected parts in 

negative X direction 
Shift + Left 

Move to Default Ctrl + F 
Move selected parts in 

positive Y direction 
Shift + Up 

Move to Default Z Ctrl + E 
Move selected parts in 

negative Y direction 
Shift + Down 

Put on Platform 
Ctrl + Shift + 

Down 

Move selected parts in 

positive Z direction 
Shift + PgUP 

Pick & Place part F9 
Move selected parts in 

negative Z direction 
Shift + PgDown 

Rotate R Move view up Up 

Scale S Move view up slightly Alt + Up 

Mirror M Move view down Down 

Duplicate Ctrl + D Move view down slightly Alt + Down 

Indicate Shift+ B Move view right Right 

Orientation Shift + U Move view right slightly Alt + Right 



14 

 

2D nesting Shift + A Move view left Left 

Section cut C Move view left slightly Alt + left 

Perforator Shift + P 

Rotate selected parts 

clockwise around X 

direction 

X 

Label Shift + L 

Rotate selected parts 

anticlockwise around X 

direction 

Shift + X 

Boolean Ctrl + B 

Rotate selected parts 

clockwise around Y 

direction 

Y 

Support module Shift + I 

Rotate selected parts 

anticlockwise around Y 

direction 

Shift + Y 

Support script Ctrl + Shift + I 

Rotate selected parts 

anticlockwise around Z 

direction 

Z 

Collision Detection Shift + K 

Rotate selected parts 

clockwise around Z 

direction 

Shift + Z 

Measure Shift + M Rotate view clockwise Ctrl + PgUp 

Fix Module Shift + R 
Rotate view clockwise 

slightly 
Ctrl + Alt + PgUp 

Mesh Reduction Shift + T Rotate view anticlockwise Ctrl + PgDown 

Transparent Parts N 
Rotate view anticlockwise 

slightly 
Ctrl + Alt + PgDown 

Exit Repair/Support Shift + Q Rotate view up Ctrl + Up 

Mark Triangle F5 Rotate view up slightly Ctrl + Alt + Up 

Mark Shell F7 Rotate view down Ctrl + Down 
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Mark Plane F6 Rotate view down slightly Ctrl + Alt + Down 

Unmark All F8 Rotate view right Ctrl + Right 

Delete Selected/Marked Del Rotate view right slightly Ctrl + Alt + Right 

Show Platform F11 Rotate view left Ctrl + Left 

Restore the default 

interactive mode 
Esc Rotate view left slightly Ctrl + Alt + Left 

Exit Alt + F4   

3 Project Management 

3.1 Open Files 

New 

With the "New" command in the File menu or the " " icon on the quick access toolbar, you 

can create a new empty project. Warning: Any changes made on previously opened projects will 

be discarded. You can add platforms or open files to the new project and perform operations. 

Open 

You can open Voxeldance Additive project files, STL files, CAD files, 3D graphics files in other 

formats, or previously saved slice files through the Open command in the File menu or the 

“ ” icon on the quick access toolbar, as shown in Figure 3.1 . If you import a CAD file, 

Voxel will automatically convert it to STL. The dialog box will allow you to specify the transform 

parameters, and you can also specify the placement of the part in the workspace. Besides, you 

can open a file and add it to the current project by dragging the valid file directly to the interface 

window. 
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Figure 3.1 Open file 

Preview File 

File Preview provides a quick preview of the part library without having to open each file. By 

clicking the name of any part file or slice file, you can preview the part in the display window, as 

shown in Figure 3.2. In the preview mode, you can also perform the basic view operations such 

as movement, zooming, and view switching. Then by clicking the Open File button, you can add 

the selected file to the current platform. 
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Figure 3.2 Preview file 

3.2 Save Files 

Save 

Through the Save command by the icon “ ” on the quick access toolbar, the current project 

will be saved and the previous files will be overwritten. 

Save As 

Click the "Save As" command in the File menu, you can define the save type, name and path for 

the file. 

Export Part 

If you need to export the part separately, select the part, and click the "Export part" command in 

the File menu or the right-click menu of the part in the part list, and the sub-menu of output 

format options will appear. Select a format, and the Save dialog will pop up, where you can save 

the part in the selected format. 
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3.3 Quick Search 

Search Function in Voxeldance Additive. As shown in Figure 3.3, all relevant features will be 

immediately displayed by entering the name of function in the search box. Clicking on the desired 

function can be launched directly. 

 

Figure 3.3 Search box 



19 

 

4 Viewing Options 

The view to the display screen can be altered in multiple ways. The intuitive mouse operation has 

been introduced in Section 2.2. Besides, the view can be adjusted by a series of standard 

commands in the VIEW menu, as shown in Figure 4.1. 

   

Figure 4.1 VIEW menu 

4.1 Perspectives 

The perspective refers to the direction and angle of viewing a part and it is indicated by the 

cubical coordinate system in the top right of the display window, with the X-Z plane of the 

coordinate representing the front panel. There are seven standard perspectives, as viewed from 

front, back, top, bottom, left, right, and isometry respectively. The isometric perspective is a view 

from the front-left-top-corner of the platform, forming a three-dimensional observation of the 

entire platform. 

There are three ways to switch between the seven standard perspectives:  

1) The view can be switched by the sub-menu commands of the ‘Perspective’ command in the 

View menu or the corresponding view icons in the toolbar, as shown in Figure 4.2. 

 

Figure 4.2 Seven standard viewing icons in the toolbar 

2) By clicking the six faces, eight vertices, and twelve edges of the coordinate cube, you can 

specify the viewing angle referring to the coordinate system to switch between different 

perspectives, as shown in Figure 4.3. 
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Figure 4.3 Directional cube 

3) Press the Space key to switch the view backwards or the Shift + Space key to switch the view 

forwards. If you do not change the perspective, the default mode is the isometric view. 

4.2 Moving and Zooming 

As described in Section 2.2, by holding the scroll wheel and moving the mouse, the entire 

platform can be shifted; and by selecting the part and dragging its central position, you can move 

the part. 

The scroll button of the mouse can be used to zoom in and out. Additionally, there are four 

default zooming control commands, as shown in Figure 4.4, which can be found in the Zoom 

menu or in the toolbar. 

 

Figure 4.4 The Zoom commands in the toolbar 

Zoom to Select 

After clicking the “Zoom to Select ” command in the Zoom submenu or toolbar, you will enter 

the mode of waiting for the users to select the area. At this time, by holding the left mouse button 

and dragging the mouse, you can create a rectangle selection area. After releasing the left button, 

the display window will zoom into the selected area, as shown in Figure 4.5.  
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Figure 4.5 Select area to zoom in 

Zoom to All Parts 

After clicking the “Zoom to All Parts ” command in the Zoom submenu or the toolbar, the 

display window will be automatically zoomed to display the entire platform and all parts in a 

suitable scale.  

Zoom to Selected Part 

After selecting one or more parts, by clicking the “Zoom to Selected Part ” command in the 

Zoom submenu or the toolbar, the display window will be automatically zoomed to display all 

the selected parts in a suitable scale.  

Zoom to Platform 

After clicking the “Zoom to platform ” command in the Zoom submenu or the toolbar, the 

display window will be automatically zoomed to display the entire platform frame. 

4.3 Displaying Options 

4.3.1 Hide/Show Parts 

With clicking “ ” icon on the left side of the part name in the part list, you can control the 

display or hide of the part. And you can also use “Hide Selected Parts” command in the right-click 

menu of part, or the shortcut keys Ctrl + H to hide the selected parts. When a part is hidden, the 

icon “ ” on the left of the part name turns “ ”. Besides, all other parts other than the selected 

parts can be set hidden by using the “Hide Unselected Parts” command in the right-click menu of 

the part. 
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By using the “Show All Parts/Hide All Parts” command in the right-click menu of any blank area 

on the platform, you can control the displaying and hiding of all the parts on the platform. By 

using the “Switch Visible/Invisible” command, you can perform the switch between the 

displaying and hiding of all parts. 

When several parts are displayed on the platform and block each other, select the part you want 

to observe, press and hold the ‘h’ key to display the part in the foreground, and release the ‘h’ 

key so it will return to the original display state. 

4.3.2 Display Mode 

There are five display modes for parts on the platform, the shadow mode, the triangular mesh 

mode, the wireframe mode, points mode and bounding-box mode, as shown in Figure 4.6. 

Through the corresponding command under the Display mode sub-menu in the VIEW menu, or 

the drop-down options of the “ ” icon in the toolbar, or the shortcut keys Ctrl + G, you can 

switch between these display modes for all the parts on the platform, with the Shade mode in 

default.  

 

Figure 4.6 Three display modes: shadow mode, triangular mesh mode, wireframe mode, point mode, 

bounding-box mode 

4.3.3 Other Display Options 

Camera Pivot 

Select the “Camera Pivot ” option in the menu, and click any point on the part surface, to make 

this point the center point of the camera. 
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Panning 

With the “Panning ” option in the toolbar, or the shortcut keys Ctrl + M, you can enter the 

panning view mode and move the view through the left mouse button, and then click the ESC 

key to exit the mode. 

Transparent Parts 

With the “Transparent Parts” option in the Display Mode submenu or the toolbar, or the shortcut 

key N, you can control whether the transparent view of the parts is displayed. 

Show Part Boundary 

With the “Part Boundary” option in the Display Mode submenu or the toolbar, you can control 

whether the sharp edges of the part on the platform are displayed with a black border. 

Show Part Projection 

With the “Show Part Projection” option in the Display Mode submenu or the toolbar, you can 

control whether the part projection on the platform is visible, as shown in Figure 4.7.  

 

Figure 4.7 Show part projection 

Show platform 

With the “Show Platform” option under the VIEW menu, you can control whether the three-

dimensional platform is visible in the display window.  

Show Ruler 

With the “Show Ruler” option under the VIEW menu, you can control whether the ruler in the 

display window is visible. 

Show Coordinate System  
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With the “Coordinate System” option under the VIEW menu, you can control whether the 

orientation indicator of the platform in the display window is visible. 

Show Part Dimensions 

With the “Part Dimensions” option under the VIEW menu, you can control whether the part 

dimensions of the part are displayed. 

Show Combined Bounding Box 

With the “Combined Bounding Box” option under the VIEW menu, you can control whether the 

bounding box size of all selected part is displayed. 

Show Random Color 

With the “Random Color” option under the VIEW menu, you can control whether to set the 

random color of the part.  

Tag ID 

With the “Tag ID” option under the VIEW menu, you can control whether the parts’ number is 

displayed. 

Tag Names 

With the Tag Names option under the VIEW menu, or clicking the icon  under the View tab in 

the lower right corner of the main interface, you can control whether the parts’ name is displayed. 

Tag Path 

With the Tag Path option under the VIEW menu, or clicking the icon  under the View tab in 

the lower right corner of the main interface, you can control whether the parts’ file path is 

displayed. 

4.4 Clipping View 

In the "Clipping" on the left tool page, you can use section cut to observe the inside of the part, 

as shown in Figure 4.8. 
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Click the selection box of the “Plane” to turn on / off the section, and then select X / Y / Z / in 

the “Plane Normal” to define how to create the section. There are several options for defining 

sections: 

1) perpendicular to the X, Y or Z axis 

2) Customize the position of the section. Enter the exact value in the "Custom" setting. 

Move the slider below to make the section move to one side. In the "Step" setting, you can 

enter a value to adjust the step size. 

Click the " " icon to reset the crop view. Click the “ ” icon to switch the hidden part of the 

part. 

 

Figure 4.8 Clip view 
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5 Part management 

5.1 Create Parts 

By creating part functions, you can create some simple 3D primitive parts. Click the "Create 

Part" command in the Home menu, a series of simple 3D parts will be listed, as shown in Figure 

5.1. Although it is only some basic geometry, you can create various required parts by changing 

the detailed parameter values. 

 

Figure 5.1 Part library 

Double-click the part to enter the parameter setting interface. These settings can be saved as 

the default settings by clicking the "Save as Default" button. Clicking the "Load from Defaults" 

button can restore the default settings after parameter changes. Clicking the "Preview" button 

can preview the part after changing part parameters, check the "Auto Preview" selection box to 

automatically preview the part after the part parameters are changed. At the same time, you 

can perform basic view operations such as moving, zooming, and switching the view. Finally, 

insert the part into the project by clicking “Create” button. 
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In the following table, a brief description of some parameters is listed: 

Parameter Features 

Name The name of the part, which displays in the part list 

Length The measured length of the X axis 

Width The measured length of the Y axis 

Height The measured length of the Z axis 

Radius The radius / size of the part 

Edges The number of edges of the part surface 

Tolerance The larger tolerances make the roundness of the part less 

accurate, and cause fewer triangles 

Height Partitions In the Z-axis direction, the triangle is divided by a certain 

number 

Rotation Angle Bending angle (hyperboloid of revolution) 

5.2 Select Parts 

When you manage or edit a specific part, you must first select it. 

a. Select in the parts list 

Select the part by checking the selection box in front of the part name in the part list. You can 

also select multiple parts at the same time by using the Shift or Ctrl key, and then check the 

selection box in front of any part to select multiple parts. Use the Ctrl + A keys can check all the 

selection boxes in front of all parts name to select all parts. 

b. Select in the display window 
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Click the "Select Part" icon on the toolbar, then click the part in the display window to select it. 

You can also hold down the Shift or Ctrl keys to select multiple parts at the same time. With Ctrl 

+ A keys, you can select all parts. 

Besides, there are several selection commands in the right-click menu of the blank area on the 

platform, including: select all parts, unselect all parts, switch selected/unselected, select all 

visible parts, and select all hide parts. 

5.3 Undo and Redo 

Through the “Undo/Redo ” icon in the quick access toolbar, or shortcut keys Ctrl + 

Z, Ctrl + Y, you can undo and redo some operations.  

5.4 Copy and Paste 

Select the parts that need to be cut or copied, click the "Cut / Copy" command in the Modify 

menu, or the shortcut key Ctrl + X / Ctrl + C, then select the platform to be placed, and then 

click the "Paste" command in the Modify menu, or the shortcut key Ctrl + V, can copy and paste 

the parts. 

5.5 Convert Units 

STL files generally work with inches or in millimeters, but do not store which unit is being used. 

Therefore, you may import a part that seems too small or too large. This will usually trigger a 

warning that your part is smaller or larger than a certain value, asking whether you would like to 

convert from inch to mm or vice versa, as shown in Figure 5.2. 

 

Figure 5.2 Unit conversion dialog 
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If this dialog does not pop up while opening a file, you can always convert units using “Convert 

inch to mm” or “Convert mm to inch” functions in Modify Ribbon. 

And you can change the parameters for automatic unit conversion from Options, as shown in 

Figure 5.3. 

 

Figure 5.3 Unit conversion settings 
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6 Part Position 

 

Figure 6.1 Part Position menu 

6.1 Move Parts 

Moving the part can be implemented by dragging its center position directly. Additionally, select 

the part, clicking the “Move” command in the Home menu, or press the shortcut key T, the “Move 

Parts” dialog for accurately setting movement parameters will pop up in the display window, and 

the part enters the movement mode of the control dimension, and the selected part displays the 

three-dimensional coordinate system, as shown in Figure 6.2.  
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Figure 6.2 Move parts setting 

The top of the settings dialog shows absolute position and relative position information: Absolute 

page for setting the absolute position coordinates X, Y, Z (relative to the origin X = Y = Z=0 

coordinates); Relative page for setting dx, dy, dz parameters relative to the current coordinates. 

After checking the Enable snapping checkbox, “Size” is in editable state, and you can set the step 

when adjusting the position parameters. If you check the “Preview” below, you can preview the 

part movement while setting the parameters; if you check the “Make copy”, a copy can be 

created at the original position after the part is moved. After setting, click Apply button to apply 

without exiting the module, and subsequent settings can be made. 

When the mouse is moved to any axis (X or Y or Z) or any coordinate plane (X-Y or X-Z or Y-Z), this 

direction will be marked as yellow highlighting. When holding down the left mouse button and 

moving the mouse, you can control the part to move only in the marked direction, that is, only in 

one of the X, Y, or Z direction or in one of the X-Y, X-Z, and Y-Z planes. If you hold down the left 

mouse button and move the mouse while pressing the Shift key, the part will be moved by integer 

steps.  

In the middle of the setting dialog, you can set the position of the starting point of the three-

dimensional coordinate system of the control dimension. There are three main ways: Click on the 

current three-dimensional coordinates range (Min, Center, Max) of the part to set; Click Custom 

of any X, Y, Z axis, you can change the parameters value in the corresponding direction to set. 

Click the “Indicate point” button, you can set the position of the selected part with the mouse. 

The default parameters can be set at the bottom of the dialog, including the default position and 

the default Z axis height. After setting the corresponding default parameters, you can save these 

values by clicking the “Save default” button. After the default parameters are saved, you can 

move the part to the specified position by clicking “Move to default”, and move the part to the 

specified height by clicking “Move to default Z”.  

After clicking the “Confirm” button to exit the module, and changing the location of the part, 

then you can directly move the part to the default location by clicking the “Move to Default” or 

“Move to default Z” command in drop-down menu or the right-click menu of part in the display 
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window. Click "Move to platform center" to move the part to the center of the platform, click 

"Put on Platform" or the shortcut key Ctrl + Shift + Down to directly place the bottom of the part 

on the platform, click "Select & place part" to enter the control dimension Mobile mode. 

6.2 Rotate Parts 

Rotating part can be implemented by directly dragging the square brackets around it. You can 

also use the shortcut keys X/Y/Z to realize the clockwise rotation around X, Y, Z axis or use the 

shortcut keys Shift + X/Y/Z to realize the counterclockwise rotation around X, Y, Z axis. Besides, 

select the part, click the “Rotate” command in the Home menu, or press the shortcut key “R”, 

you can set the rotation parameters accurately in the Rotate Parts dialog displayed in the view 

window. When the dialog box is opened, the part enters the rotation mode of the control 

dimension, and the selected part displays the three-dimensional coordinate system, as shown in 

Figure 6.3.  

 

Figure 6.3 Rotate parts setting 

You can set the rotation angles around the X, Y, and Z axis respectively in the Rotate angles.  After 

checking the “Enable snapping” checkbox, “Size” is in editable state, and you can set the step 

when adjusting the rotation angle parameters. If you check the “Preview” below, you can preview 
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the part rotation while setting the parameters; if you check the “Make copy”, a copy can be 

created at the original position after the part is rotated. After setting, click Apply button to apply 

without exiting the module, and subsequent settings can be made. 

The coordinates of the rotation center can be set in the Rotate center drop-down menu at the 

bottom of the dialog, there are main four ways: Rotate around the center points of multiple parts; 

Rotate around the center of each part; Define part center point to rotate; Click Indicate point 

button, then specify a position on the part as the center point to rotate.  

Besides, in the control dimension mode, when the mouse is moved to the circular area of any 

axis (X or Y or Z), the circular area in the direction will be marked as yellow highlighting. At this 

point, holding down the left mouse and dragging, the part can be controlled to rotate only in that 

direction (that is only in one of the X, Y, or Z direction). 

6.3 Scale Parts 

Select the part, click the “Scale” command in the Home menu, or press the shortcut key “S”, you 

can set the scale parameters accurately in the “Scale Parts” dialog displayed in the view window, 

as shown in Figure 6.4.  
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Figure 6.4 Scale parts setting 

You can set the scale and size of the X, Y, or Z dimension respectively in the top of the dialog. If 

the “Uniform” check box at the bottom is checked, and if the parameter in any dimension is 

changed, the other dimension data will be changed in the same proportion to maintain the 

original shape. Otherwise, independently setting the three-dimension parameters may cause 

deformation or stretch effects; If you check the “Preview” below, you can preview the part scale 

while setting the parameters; if you check the “Make copy”, a copy can be created at the original 

position after the part is scaled. If you check the “Keep original Z” box, the original Z axis does 

not change after the part is scaled. 

The scale center can be set in the Scale center drop-down menu at the bottom of the dialog. After 

checking the “Around each center” box, all parts will be scaled around their respective center 

points. 
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The scale factor scripts can store the scale factor. You don't need to open the “Scale Parts” dialog, 

you can directly click on the drop-down button of the Scale menu and select a script to quickly 

scale the part. Click the "Add" button to create a new scale factor script, as shown in Figure 6.5. 

Select an added script, click the "Edit" button to edit the script name and scaling parameters, and 

click the "Delete" button to delete the selected script. 

 

Figure 6.5 Scale Part 

 

6.4 Mirror Parts 

Symmetric mirroring transformation of the part can be realized with the Mirror Parts command. 

Select the part, click the “Mirror Parts” command in the Home menu, or press the shortcut key 

“M”, the Mirror Parts parameter setting dialog will pop up in the view window, as shown in Figure 

6.6. You can choose the XY or XZ or YZ plane in the Mirror panel tab. The default symmetry plane 

is the three middle axis planes of the part (that is, on their own symmetry). If you check the 

“Preview” below, you can preview the mirroring of the part while setting the parameters; by 

checking the “Make copy”, you can create a new symmetric copy, otherwise the symmetry 

transformation is performed only on the original part.  By checking the “Use center parts” box in 

the Plane Position tab, you can change the default symmetry plane position.  
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Figure 6.6 Mirror Part setting 

6.5 Duplicate Parts 

Select the part, click the "Duplicate Parts" command in the Home menu, or press the shortcut 

key “Ctrl + D”, and the Duplicate Parts parameter setting dialog box will pop up in the view 

window, as shown in Figure 6.7. Enter the total copy of parts (> = 1, including original parts), 

and set the required number and spacing in the three directions of X, Y, and Z respectively. 

Check the "Preview" selection box to preview the duplicated parts while setting the 

parameters. Check the "Fit to platform" selection box to place the duplicated parts in the 

platform.  

 

Figure 6.7 Duplicate parts setting 
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6.6 Indicate Plane 

Select the part, click the "Indicate" command in the Home menu, or press the shortcut key “Shift 

+ B”, and the Indicate Bottom/Upper Plane parameter setting dialog box will pop up in the view 

window, as shown in Figure 6.8. 

     

Figure 6.8 Indicate Bottom/Upper plane setting (left) and plane selection (right) 

If the "Mark Plane" button in the dialog is in orange, it indicates a selecting state; otherwise, click 

this button to turn it orange. Then select a plane on the part surface, the selected plane will be 

marked as yellow, and then click the Apply button at the bottom, you can realize the flip of the 

part, so that the selected plane is parallel to the platform surface. 

The Bottom Plane and Upper Plane options in the Indicate panel field are used to place the 

selected plane face down or up, that is, and 180-degree flip. More transformation options are 

available in the Position field, including Keep Original Z Position, Translate to coordinate origin, 

Translate to platform and Translate to default position. 

The Plane Making parameters field is used to set the error range of the selected surface, including 

the Surface Tolerance and Angle Deviation. The higher the set value is, the larger the selected 

surface range will be.  
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6.7 Orientation 

6.7.1 Orientation 

Using the Orientation Optimizer function can adjust the parts to the optimal placement position, 

which is beneficial to the later support operations. 

Select the part, and click the “Orientation Optimizer” command in the Orientation drop-down 

menu under the Home menu. The Orientation Optimizer Setting dialog will appear in the display 

window, as shown in Figure 6.9. 

 

Figure 6.9 Orientation Optimizer setting 

The dialog provides four optimization criteria: Print time, Support area, Support volume, 

Bounding box volume. 

Print time: adjust the part to the proper position to make it has the least print time after 

supporting. 

Support area: adjust the part to the proper position to make it has the minimal support bottom 

area after supporting. 

Support volume: adjust the part to the proper position to make it has the minimal support volume 

after supporting. 

Bounding box volume: adjust the part to make its boundary bounding box volume smallest. 



39 

 

At the same time, in the setting, you can set the size of the surface critical angle when adding the 

support and the distance from the lowest point of the part to the platform. 

After the setting is completed, click “Confirm”, the selected part completes the automatic 

placement according to the setting. 

6.7.2 Orientation Comparator 

The Orientation Comparator function is to adjust the parts to the optimal placement position in 

a more intuitive way, which is conducive to later support operations. 

Select the part, and click the “Orientation Comparator” command in the Orientation drop-down 

menu under the Home menu, or press the short keys “Shift + U”, the Orientation Comparator 

Setting dialog will appear in the display window, as shown in Figure 6.10. 

 

Figure 6.10 Orientation Comparator setting 

Orientation comparator provides five optimized standard parameter settings for part 

placement, including Support area weight, Support volume weight, Part height weight, 

Projection area weight, and Bounding box volume weight. These five parameters can be set 

individually by sliding the scroll bar or directly entering specific values in the parameter box. 

Support area weight: adjust the support area when the part is added with support, the larger 

the weight, the smaller the support area; 
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Support volume weight: adjust the support volume when the part is supported, the greater the 

weight, the smaller the support volume; 

Part height weight: adjust the height of the part, the greater the weight, the lower the part’s 

position, the better to add support; 

Projected area weight: adjust the projected area of the part, the larger the weight, the smaller 

the projected area of the part. 

Bounding box volume weight: adjust the volume of the bounding box of the part boundary, the 

larger the weight, the smaller the bounding box volume; 

The critical angle in the Setting field is the same as the angle of the critical surface in the 

support operation (see Chapter 9); check the "Distance to platform" checkbox to set the 

distance from the lowest point of the part to the platform. 

After setting all parameters, click the “Optimize” button to display a comparison table of the 12 

orientation of part, as shown in Figure 6.11. Select each orientation of part, the part will do the 

corresponding operation. In these 12 orientations, click the column headings to sort in 

ascending or descending order, and click on different rows to see the suggested orientations 

and the support required in that orientation. The more green mark in a row, the better the 

orientation of part. the orientation that is sorted by 0 is selected by default. 

After selecting an orientation, and click "OK", the selected parts will complete the placement 

according to the selected orientation. 
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Figure 6.11 Orientation comparator table 

6.7.3 Minimize Bounding Box 

This feature minimizes the bounding box by rotating the part, but the size of the part itself does 

not change. 

Select the part, and click the "Minimize Bounding Box" command in the Orientation drop-down 

menu under the Home menu. A dialog box for setting the parameter of the minimized bounding 

box will pop up in the display window, as shown in Figure 6.12. 
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Figure 6.12 Minimize Bounding Box setting 

The setting dialog provides three parameter setting modes for minimizing the bounding box of 

the part, which are Volume, Base area, Base area and height. 

Volume: The bounding box has the smallest volume and chooses whether to set the longest 

side to be horizontal. 

Base area: The base area of the bounding box is the smallest, and whether to rotate only 

around the Z axis. 

Base area and height: The base area and height of the bounding box are the smallest at the 

same time. 

Besides, the position of the part can be set at the bottom of the dialog. You can choose 

whether to keep the minimum Z position or keep the part center. 

After the setting is completed, click "Apply", and the selected parts will be placed according to 

the settings, as shown in Figure 6.13. 

                      

Figure 6.13 The effect of minimal bounding box volume 

6.7.4 Orientation Optimizer for Teeth 

This function is mainly for the placement of multiple teeth, so that their crowns are 

automatically placed upwards. 
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Select the teeth part, and click the "Orientation Optimizer for Teeth" command in the 

Orientation drop-down menu under the Home menu. A dialog box for setting the teeth 

orientation optimizer parameters will pop up in the display window, as shown in Figure 6.14. 

 

Figure 6.14 Orientation Optimizer for Teeth setting 

If "All parts" is selected, the orientation optimization is performed for all the tooth parts on the 

platform. If "Select parts" is selected, the orientation optimization is performed only for the 

selected tooth parts. 

If "Move part to Z height" is checked, the tooth part will be moved to the set Z height for 

orientation optimization. If it is not checked, the orientation is optimized at the original position 

of the part. 

If 2D nesting is checked, the parts can be placed automatically and orderly while the orientation 

is optimized. For details, refer to Chapter 6.8. 

After the setting is completed, click "Apply", the tooth parts on the platform will be optimized 

for orientation according to the settings, and the optimized picture is shown in Figure 6.15. 
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Figure 6.15 Dental crown automatically placed upwards effect 

6.8 2D Nesting 

When multiple parts are placed on the platform, the parts can be automatically arranged by the 

2D nesting function.  

Select the part, and click the “2D Nesting” command under the Home menu, or press the short 

keys “Shift + A”, the parameter setting dialog box will pop up, as shown in Figure 6.16. The setting 

dialog mainly include five parts: Selection setting, Accuracy setting, Space setting, Rotation 

setting and Nesting solution. 
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     Figure 6.16 2D nesting setting 

If "All parts" is selected, all parts on the platform will be placed in two dimensions. If "Selected 

parts" is selected, only the selected parts will be placed, and there are two placement modes for 

unselected parts. One is to keep the unselected parts in the original place, and the other is to 

move the unselected parts outside the platform. 

In the accuracy setting section, you can choose the placement accuracy. The higher the accuracy, 

the longer the placement time. 

In the space setting section, you can clearly define the part interval and the distance from the 

part to the platform boundary. The specific parameter explanation is shown in Table 6.1. 

Table 6.1 Space setting parameters 
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Part interval Minimum distance between two parts 

Margin to sides Minimum distance from part to platform boundary 

Move parts to Z height 

Move the part to the specified Z-axis height for placement. If the 

part has support, you can choose not to move the part to retain the 

support, or move the part but refresh the support 

In the rotation setting part, the specific parameters are explained in Table 6.2. 

Table 6.2 Rotation setting parameters 

Align parts’ main 

direction to X-axis 

If checked, during part placement, rotate the part so that its main 

direction is parallel to the X axis 

Align parts’ main 

direction to Y-axis 

If checked, during part placement, rotate the part so that its main 

direction is parallel to the Y axis 

Z-Rotation steps 

Provides multiple step sizes to rotate around the Z axis 

 

No rotation: the part does not rotate around the Z axis 

90 °: The rotation step is set to 90 °, which provides four possible 

placement positions during placement 

60 °: The rotation step is set to 60 °, which provides six possible 

placement positions during placement 

45 °: The rotation step is set to 45 °, which provides eight possible 

placement positions during placement 

30 °: the rotation step is set to 30 °, which provides twelve 

possible placement positions during placement 

20 °: The rotation step is set to 30 °, which provides eighteen 

possible placement positions during placement 

In the Nesting solution section, specific parameter explanations are shown in Table 6.3. 
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Table 6.3 Nesting solution parameters 

Minimal surface area Minimal total surface area for parts 

Minimal convex hull area Minimal convex hull area for parts 

Maximal parts adjacency Place the parts next to each other best 

Minimal X-dimension Minimal total surface area in the X direction 

Minimal Y-dimension Minimal total surface area in the Y direction 

After the setting is completed, click "OK", the parts on the platform will be placed in two 

dimensions according to the settings. After placement, the effect picture is shown in Figure 

6.17. 

 

Figure 6.17 Two-dimensional nesting effect 

6.9 3D Nesting 

6.9.1 3D Nesting 

The 3D nesting function ensures an optimal load of the sintering machine(s) when using the 

selective laser sintering technology. Considering the geometry of the parts, the software 
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maximizes the construction and packaging of parts on the platform and minimizes build time. At 

the same time, the software ensures that no collisions will occur between any parts after 

placement. 

Select the part, and click the "3D Nesting" command in the 3D Nesting drop-down menu under 

the Home menu. the parameter setting dialog box will pop up in the display window, as shown 

in Figure 6.18. The settings dialog includes four sections: Selection setting, Accuracy setting, 

Space setting and Rotation setting. 

 

Figure 6.18 3D nesting setting 

If "All parts" is selected, all parts on the platform will be placed in three dimensions. If "Selected 

Parts" is selected, only selected parts will be placed, and unselected parts will be placed outside 

the platform. 

In the accuracy setting section, you can choose the placement accuracy. The higher the accuracy, 

the longer the placement time. 

In the space setting section, you can clearly define the part spacing and the distance from the 

part to the platform boundary. The specific parameter explanation is shown in Table 6.4. 

Table 6.4 Space Settings parameters 
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Part interval 

This value refers to the minimum distance between two pre-processed 

parts. 

 

 

Margin to sides 

The minimum distance from the parts to the platform boundary after 

packing. 

 

 

5mm 

10mm 
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Limit platform height 

Check the box to set the maximum height of the part placed on the 

platform. If not checked, the default is placed within the entire height 

range of the platform. 

Do not check the selection box: 

 

The platform height is limited to 200mm: 

 

The platform height is limited to 100mm: 
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In the Rotation settings section, the specific parameters are explained in Table 6.5. 

Table 6.5 Rotation Settings parameters 

Z-Rotation steps 

Provides a variety of step sizes for rotation around the Z axis 

 

No rotation: The part does not rotate around the Z axis. 

90°: The rotation step is set to 90°, and four possible placement 

positions are available during the placement process. 

60°: The rotation step is set to 60°, and six possible placement 

positions are available during the placement process. 

45°: The rotation step is set to 45°, and eight possible 

placement positions are available during the placement process. 

30°: The rotation step is set to 30°,  and twelve possible 

placement positions are available during the placement process. 

Rotate XY Axis 
After checking, the part is rotated around the XY axis during the 

placement process and by default, it is checked. 
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After the setting is completed, click “Confirm”, the parts on the platform will be placed in three 

dimensions according to the settings, and the effect picture is shown in Figure 6.19. 

 

Figure 6.19 3D nesting effect 

After the parts are placed, you can check whether there is a collision between the placed parts 

by using the Collision Detection command under the Analysis menu (refer to Section 10.1). 

6.9.2 Sub-nester 

Sub-nesting is pre-nesting the selected parts before creating the sintering box. In this way, small 

and fragile parts can be nicely nested well. 

Select some parts, and click the "Subnester " command in the 3D Nesting drop-down menu under 

the Home menu, and the sub-nesting parameter setting dialog will pop up in the display window, 

as shown in Figure 6.20. 
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Figure 6.20 sub-nester setting 

In the Accuracy setting section, you can choose the placement accuracy. The higher the accuracy, 

the longer the placement time. 

In the Space settings section, you can define the minimum distance between parts. 

In the Rotation setting section, you can set the rotation step around the Z axis and whether to 

rotate the XY axis. 

After the setting is completed, click "OK". The selected parts on the platform will be placed in 

sub-nested according to the settings. The effect picture after the placement is shown in Figure 

6.21. 

 

Figure 6.21 Sub-nester setting 
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6.9.3 Rectangle SinterBox 

Using the rectangle sinter box function, small and fragile parts can be protected in a small box 

for easy removal from the powder later. 

Select some parts, click the "rectangular sintering box" command in the 3D Nesting drop-down 

menu under the Home menu, and the dialog for setting the parameters of the rectangle sinter 

box will pop up in the display window, as shown in Figure 6.22. The setting dialog include three 

parts: Space setting, Perforations and Tag. 

 

Figure 6.22 Rectangular sinter box setting 
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In the Spacing setting part, you can clearly define the part gap and the thickness of the sintering 

box. The specific parameters are explained in Table 6.6. 

Table 6.6 Space setting parameters 

Margin to part 
The minimum distance between (the bounding box of) a part and 
the edge of the sinter box  

Thickness The wall thickness of the box, except the cover thickness  

Cover thickness The wall thickness of the cover of the box  

In the Perforation setting section, the specific parameter explanation is shown in Table 6.7. 

Table 6.7 Perforation setting parameters 

Perforated 
If checked, the sintering box can be perforated, so that it is easier to 
let the powder flow out before removing the parts, if not checked, 
no perforation 

Size Define the size of the perforation  

Interval The distance between two perforations 

In the label setting section, in order to easily find which parts are located in the sinter box, you 

can create labels. The specific parameter explanations are shown in Table 6.8. 

Table 6.8 Label setting parameters 

Text Type here the text you’d like to have on the Sinterbox.  

Part Name This function will enter the first part names as text to the label.  

Change Font 
The font can be changed in a dialog when you push the Change Font 
button.  

Show total amount of parts 
inside 

The total amount of parts inside the Sinterbox is displayed on the 
label.  

Margin to side Distance between text and edge of the box. 

Depth The label will be put on the part in relief with the given depth.  

Direction 
Inside The letters will be engraved in the Sinterbox.  

Outside The letters will be on the Sinterbox 

After the setting is completed, click "OK". The selected parts on the platform will build a 

rectangular sinter box according to the settings. The effect picture is shown in Figure 6.23. 
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Figure 6.23 Effect of rectangular sinter box with perforations 
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7 Part Edit 

 

Figure 7.1 Part Edit menu 

7.1 Section Cut 

7.1.1 Section Cut 

Click the "Section Cut" command in the Section Cut drop-down menu under the Home menu, 

and the section cut setting dialog box will pop up in the display window, as shown in Figure 7.2. 

 

Figure 7.2 Section cut setting 
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If "All Parts" is selected, all parts on the platform will be cut. If "Selected Parts" is selected, only 

the selected parts will be cut, even if the cutting plane is inserted on unselected parts, do the 

corresponding cutting. 

To place the cutting plane, there are six options: clicking three points on the part to define the 

plane and then places it, placing the plane along the direction of the part surface, placing the 

plane perpendicular to the surface direction of the part, and placing the plane parallel to the X-

Y, X-Z, Y-Z plane directions. By default, the cutting plane is blue and is marked by dots at its 

center, corner and edge center. 

You can select the four ways to insert the cutting plane by clicking the following icons respectively: 

: Creating a cutting plane by three points. After clicking on any three points on the part, and 

inserting the cut plane defined by these three points, then you can preview the plane when you 

place the third point. The last point selected is the center of the plane, as shown in Figure 7.3. 

 

  Figure 7.3 Create a cutting plane at three points  

: Creating a tangent plane that is tangent to the surface. After clicking on any point on the 

part, you can create a cutting plane parallel to the triangle where the point is located, as shown 

in Figure 7.4. 
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  Figure 7.4 A cutting plane tangent to the plane  

: Creating a cutting plane perpendicular to the surface. After clicking on any point on the 

part, you can create a cutting plane perpendicular to the triangle where the point is located, as 

shown in Figure 7.5. 

 

Figure 7.5 A cutting plane perpendicular to the plane  

: Creating a cutting plane parallel to the XY, XZ, and YZ planes. Taking an example 

parallel to the X-Y plane, after clicking on any point on the part, you can create a cutting plane 

parallel to the X-Y plane where the point is located, as shown in Figure 7.6. 
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Figure 7.6 A cutting plane parallel to the XY plane 

The plane can be moved and rotated and its size can also be changed by dragging and dropping 

the mouse through the points on the plane. 

If you use the mouse to click and drag the center point of the plane, as shown in Figure 7.7, you 

can move the entire plane freely; if you click the points on the edge and the corners, you can 

rotate the plane; if you hold down the Ctrl key, then click and drag the points on the edges and 

the corner, you can change the size of the plane. 

         

Figure 7.7 Plane center point               Figure 7.8 Plane corner point              Figure 7.9 Edge center point 

If you move the point on the corner, as shown in Figure 7.8, the plane will rotate about the axis 

perpendicular to the plane, and the plane stays in its original position, only its edges and corners 

move. If you move the center point on the edge, as shown in Figure 7.9, the plane will rotate 

along the clicked edge axis paralleled to the edge. You can adjust the cutting surface to any 

position by rotating its each side.  
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After inserting the cutting plane, you can also set the value of the cutting plane in the settings 

dialog, so that you can more accurately fine-tune and position the plane. 

In the Options setting, there are 2 options, as shown in Figure 7.10. You can enable or disable 

these functions by checking or unchecking them. 

 

Figure 7.10 Plane information parameter setting 

If "Remove original part(s)" is checked, you can delete the original part and replace it with the 

cut part. If you do not remove them, they appear behind the cut part after cutting. 

If "Use plane boundary" is checked, you can only cut along the outer edge of the plane. If this 

option is not checked, the part will be cut completely along the plane, regardless of the size of 

the displayed cutting plane. 

In the Advanced Section Cut section, check "Use advanced cut" to enable this advanced cutting 

function, as shown in Figure 7.11. 
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Figure 7.11 Advanced section cut setting 

There are two types of section cut, pins/holes setting and lap joint setting.  

a. Pins/ Holes type setting 

Table 7.1 Pins/Holes type 

   

Pins：The connection ways of the two sides after the section cutting are different, 

one side is pin connection, and the other is hole connection 

Holes：The connection ways of the two sides after the section cutting are same, 

both sides are hole connection 
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Pins cut                                            Holes cut 

Table 7.2 Cylinder settings of the Pins/Holes cut 

 

Radius：The radius of pins after cutting 

Tolerance：The tolerance parameter has a great influence on the formation of the 

triangles after cutting 

Height：The height of the pins after cutting 

Side distance：The distance from the part boundary to the pin 

       

Side distance =4mm            Side distance =12mm 

Table 7.3 Clearance settings of the Pins/Holes cut 
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Top clearance：The top clearance of the pins 

Spacing：The distance of the pins 

Side clearance：The side clearance of the pins 

Face clearance：The face clearance along the cutting direction and it facilitates 

rapid recovery of the part after cutting 

     

Spacing =4mm                      Spacing =12mm 

After setting the parameters, click the “Save” button to save the parameter settings. 

b. Lap joint setting 

Table 7.4 Lap Joint type 

   

After cutting, the two sides of the connection are differently. One side is convex 

connection and the other side is concave connection. 
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Table 7.5 the Parameter settings of the Lap Joint 

 

Notch depth: Defines the height between the top and bottom incision 

plane.  

Side distance: The distance between the wall of the part and the step in 

the cutting surface.  

      

  Side distance =10mm                Side distance =20mm 

Table 7.6 the Clearance settings of the Lap Joint 

 

Notch clearance: Make a little gap along the cut. This way the two parts can 

easily slide into each other if you have to assemble them.  
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Front clearance: Clearance added in the direction perpendicular to the 

section.  

Back clearance: Clearance added in the direction parallel to the section.  

Finally, click OK to perform the part cutting. The cut part name is displayed in the parts list on the 

left. 

7.1.2 Polygon Cut 

Click the "Polygon Cut" command in the Section Cut drop-down menu under the Home menu, 

and the Polygon Cut Settings dialog box will pop up in the display window, as shown in Figure 

7.12. 

 

Figure 7.12 Polygon cut setting 
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If "All Parts" is selected, all parts on the platform will be cut. If "Selected Parts" is selected, only 

selected parts will be cut. Even if the cutting plane is inserted on non-selected parts, it will not 

do the corresponding cut. 

In the first polygon mode , you can create and edit polygons. With left-clicks on the part, you 

set corner points for the cutting line. And in the default color setting, the points appear as a black 

square and the cutting line is red. When you set the third corner point, the first and last point are 

connected, so that the cutting line becomes a triangle. More corner points make it a polygon, 

and the added corner points are always connected to the two corners points attached to the 

closest line. Left click on the corner point and dragging the mouse can change the location of the 

corner point, and right click on the corner point can delete the point in the pop-up menu.  

In the following parameter settings, there are Round corners and Clearance settings. If “Rounded 

corners” is checked, the corners of the polygon will be smoothed. The input value defines the 

radius of the rounded corners. If the “Clearance” is checked, you can define its thickness, and 

then you can choose whether to add space inside, outside or both sides of the cutting line. By 

adding a clearance, the space between the two cutting lines can also be cut off, which is helpful 

for that the contours swell up a little in the 3D printing. The effects of Round corners and 

Clearance settings are shown in Figure 7.13. 

 

Figure 7.13 Left: Rounded corners on both sides, Right: The cut part 

After the polygon is created on the part, the “Add-teeth” button is in an editable state. Click the 

“Add Teeth" button to enter the boundary shape setting module. The setting dialog pops up in 

the display window, as shown in Figure 7.14. 
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Figure 7.14 Add teeth setting 

Under the Teeth style tag, you can select the type of teeth line. There are three main types, and 

each type and its corresponding parameters are explained in Table 7.7. 

Table 7.7 “Add Teeth” parameter settings 

Teeth line type 

Jagged 

 

Dove 

tailed 
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Puzzle 

 

Width The width of the teeth structure  

Height The height of the teeth structure 

Count Setting the specific number of teeth structures on a boundary 

Distance Distance between two teeth structures 

Offset 
The distance from the beginning of the cutting boundary to 

the boundary of the first toothed structure 

Flip Teeth 
After clicking Flip Teeth, the tooth profile on the cutting 

boundary is inverted 

Apply to all edges When checked, all cutting edges are toothed 

After selecting the appropriate teeth type and setting the corresponding parameters, you can 

add a teeth line to a cutting line selected by the left mouse, then click the Apply button to apply. 

The tooth addition of each cutting line is independent of each other. Right-click the teeth line 

and click "Delete selected teeth" to delete the teeth structure added to this cutting line. Click 

"Delete all teeth" to delete the teeth structure on all cutting lines. Finally, click the Confirm 

button to exit the add teeth module, as shown in Figure 7.15. 
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Figure 7.15 Effect of adding different teeth style 

In the above plane cutting and polygon cutting operation, after clicking a cutting icon, the 

mouse will carry the corresponding icon, such as . During the execution of this function, the 

mouse will always carry the icon until it switches to other functional operation icons. 

With a click on the circle icon , the predefined shape of a circle cut will be previewed on the 

part. Then you can adjust its size by entering the exact radius value, or by dragging the round 

edge line with the mouse. The tolerance value determines the deviation between the circle 

drawn by the program (a polygon) and a real circle. It is the distance along the radius 

perpendicular on and through the middle of one of the edges of the polygon between the cross 

point of the radius with the polygon and the cross point of the radius with the circle. The higher 

the tolerance, the bigger the deviation. Besides, Notch and Clearance can be set, as shown in 

Figure 7.16. 

 

Figure 7.16 Left: Notch and clearance on both sides, right: After cutting 

With a click on the rectangle button , the predefined shape of a rectangle cut will be 

previewed on the part. Then you can adjust its size by entering the exact length and width, or by 

dragging the center point displaying on the rectangle edge with the mouse. You can also set 

Notch and Clearance, the effect is shown in Figure 7.17. 
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Figure 7.17 Left: Round corner and clearance on both sides, right: After cutting 

With a click on the Delete button , the added cut corners will be deleted and automatically 

return to the edit polygon mode. 

In order to observe the cutting effect more clearly, you can click the preview button  to 

preview the cutting effect. The part to be cut is in yellow color and clicking the stop button  

to stop the preview operation. Click the reset button  to clear all cutting line segments on the 

part. After setting the cutting point, you can use the right mouse button to rotate the perspective 

to know the shape of the cutting line at each viewing angle. 

In the Cutting option, if you check "Remove original part", you can delete the original part and 

replace it with the cut part. If you do not remove them, they will appear in front of the cut part 

after the cut. 

Clicking the “Advanced standard view options” drop-down menu at the bottom of the dialog, you 

can enter the advanced standard view options settings interface. After clicking one of the six 

standard viewing angles: front, rear, top, bottom, left, right, the parameter settings in advanced 

standard view options are displayed as editable. Take clicking on the top view for example, as 

shown in Figure 7.18. After checking the “Cut till Z=” box, you can only cut to the specified Z axis 

height; after checking the “Show coordinate” box, the coordinate information of all the cutting 

corners will be displayed, and the coordinate information under the “Move selected point to” is 

in an editable state, you can change the coordinates of a selected corner point; after clicking the 

“Add Point” button, the Coordinates dialog will pop up, then you can add corner points at the 

specified position, as shown in Figure 7.19. 
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Figure 7.18 Advanced standard view options Settings 

 

Figure 7.19 Add corner points at the specified position 

7.2 Hollow 

7.2.1 Hollow 

By creating a concentric (identical shape) new shell at a certain thickness inside or outside the 

part and merging with the original part, you can create a hollow part with the same appearance. 

Select the part, and click the "Hollow" command in the Hollow drop-down menu under the Home 

menu, and a dialog box for setting parameters will pop up, as shown in Figure 7.20. The Wall 

Thickness parameter specifies the distance over which the triangles of the original shell get an 

offset in order to generate a hollow part. The Accuracy parameter specifies the hollow accuracy, 

and the Accuracy value is lower, the number of triangular mesh is greater, and the graphics 

accuracy, the computational complexity is higher. The Direction option specifies where the new 

shell is created: Inside refers to create an inner shell inside surrounded by the original part; 

Outside refers to creating the outer shell on the outside and enclosing the original part. Finally 

click the Confirm key to complete the hollow operation, the original part will be overwritten. 
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Figure 7.20 Hollow Operation (left) and Result (right) 

7.2.2 Shell 

Mark the surface on the part to delete, the rest of part will be hollowed out. 

Select the part, mark the surface to be deleted, and click the "Shell" command in the Hollow 

drop-down menu under the Home menu, and a dialog box for setting parameters will pop up, 

as shown in Figure 7.21. The Wall Thickness parameter specifies the distance over which the 

triangles of the original shell get an offset in order to generate a hollow part. The Accuracy 

parameter specifies the hollow accuracy, and the Accuracy value is lower, the number of 

triangular mesh is greater, and the graphics accuracy, the computational complexity is higher.  

Finally, click the “OK” button to complete the shell operation, and the original part will be 

overwritten. 

 

Figure 7.21 Shell Operation (left) and Result (right) 

7.3 Extrude 

Use the extrude function to extrude triangles in the certain direction, allowing you to quickly 

reshape parts without using CAD software. 
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Select the part, and click the "Extrude" command in the Home menu. A dialog box for setting 

parameters will pop up, as shown in Figure 7.22. 

 

Figure 7.22 Extrude setting 

Table 7.8 Extrude parameters setting 

Offset Specify the extrude offset.  

Extrude 

type 
Move points 

The triangles adjacent to the selected triangles will be 

redrawn. They are stretched like shown in the figure 

below. The common points are moved. The area of the 

surface formed by the triangles that are extruded will stay 

the same after extrusion. The slope of the adjacent 

triangles will change a bit.  

 

 

Add triangles 

The triangles adjacent to the triangles that are extruded 

stay the same. The common points of the selected and 

adjacent triangles remain on their position. The gap 

between the latter and the triangles that have undergone 
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an offset is filled with new triangles. This is shown in the 

figure below.  

 

Direction 

Automatic The program will make the best choice of extrude direction. 

Set 

extrude 

direction 

X、 Y、 

Z 

You can give an extrude direction coordinates in the X, Y 

and Z field.  

Indicate 

line 

You can click the Indicate Line button and afterwards click 

on a line. The extrude offset will be in the direction of the 

line.  

Indicate 

triangles 

You can click the Indicate Triangle button and afterwards 

click on a triangle. The extrude offset will be the direction 

of the normal of the triangle.  

7.4 Offset 

The Offset function allows offsetting the whole part or some selected triangles. The triangles are 

moved along a direction proper to the normal of that triangle over a defined distance, which is 

the same for all triangles. 

7.4.1 Global offset 

Select the part, and click the "Global Offset" command in the Offset drop-down menu under the 

Home menu. A dialog box for setting parameters will pop up, as shown in Figure 7.23. 
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Figure 7.23 Global offset setting 

Offset X, Y, Z: Enter the offset value, and each triangle will be moved along the direction of its 

normal over a distance set by the offset value.  

Uniform offset: If you want to apply the offset to X, Y, and Z uniformly, check "Uniform offset". If 

you do not check "Uniform offset", you can set different offset values in the X, Y, and Z fields. 

Create Thickness: Preserve the original shell and create thickness. 

Direction: Choose whether the offset is inward or outward. 

7.4.2 Local offset 

Select the part, and click the “Local Offset” command in the Offset drop-down menu under the 

Home menu. A dialog box for setting parameters will pop up, as shown in Figure 7.24 

 

Figure 7.24 Local offset setting 
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Offset: Select (mark) triangles on the part and enter offset values. These triangles will be moved 

by the distance set by the offset value. 

Move point: The triangles adjacent to the selected triangles will be changed. The common points 

are moved. The area of the triangles selected remains the same after the offset. The slope of the 

adjacent triangles will change a bit.  

Add triangle: The common points of the selected and adjacent triangles remain on their position. 

The gap between these triangles and the triangles that have undergone an offset is filled with 

new triangles.  

Direction: Choose whether the offset is inward or outward. 

The effect of moving the points outwards and adding triangles is shown in Figure 7.25. 

                       

Figure 7.25 Original part (left)，Move points (middle)，Add triangles (right) 

Remark: The local offset differs from the Extrude operation. In an extrude operation all triangles 

are moved along the same direction. In the local offset operation, the direction of offset depends 

on the triangle and its neighbors. 

7.5 Perforator 

Click the "Perforator " command under the Start menu, or the shortcut key Shift + P to open the 

Add Holes dialog box, as shown in Figure 7.26. 
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Figure 7.26 Add holes parameter setting 

By clicking the " " button at the bottom of the settings dialog, you can add a perforation part 

body on the part, as shown in Figure 7.27. By default, the part body is bright yellow, and after 

placing the part body in the location to be perforated, then clicking the left mouse button, you 

can add the part body on the part, and by clicking " " button, you can delete the added part 

body, then clicking "Apply" button, you can achieve the perforator operation of the part and a 

hollow part is generated. 
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Figure 7.27 Perforator operation (left, middle) and result (right) 

In the Hole size setting, you can set the radius of the outer circle, the radius of the inner circle, 

the protrusion length of the outer circle, and the protrusion length of the inner circle, as shown 

in Figure 7.28. If you check the "Use notch", you can add a notch in the perforation part body, as 

shown in Figure 7.29. 

      

Figure 7.28 Hole size parameter setting 

    

Figure 7.29 Use notch setting 

For the "Keep subtracted parts" checkbox, you can choose whether to retain the perforation part 

body and whether to add clearance between the part and the perforation part body. By default, 

the checkbox is not checked, and after the perforator operation, the perforation part body is 

removed directly from the part and a hollow part is generated; if you need to retain the part body, 

check on it. If you want to make a clearance between the two sections after the perforation, you 

can add a gap distance, there are three types: Inside, Outside, Both sides. Inside refers that the 

clearance is reduced from the perforation part body; Outside refers that the clearance is reduced 

from the part; Both sides refers that the gap is reduced from both sides, the perforation part 
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body reduces half of the gap, and the part reduces half of the gap. The result of these three types 

are shown in Figure 7.30. 

 

Figure 7.30 Effect after perforator: Not retained(a)，Inside(b)，Outside(c)，Both sides(d) 

7.6 Prop 

To avoid distortion on your part during building you can create “props” to make sure that the 

shape of the part is kept. 

Select the part, and click the "Prop" command in the Home menu. A dialog box for setting 

parameters will pop up, as shown in Figure 7.31. 

  

Figure 7.31 Prop generation setting 

: When you click this add icon, prop can be drawn on the part, but not yet created. To better 

see where the prop is placed, you can check “Preview”. 
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: Click this delete button, you can delete unnecessary prop. 

Prop type: Circle / Square. The shape of the prop can change between circles or squares. 

Strong-section width (a): The width of the circle/ square connector, as shown in Figure 7.32. 

End-section width (b): The width of the connection (between the strong section and the part). 

End-section length (c): The length of the connection between the strong section and the part. 

 

Figure 7.32 Parameter diagram 

Boolean Merge: The part and prop(s) are united into one file and all surfaces are trimmed to 

make one shell of both parts.  

Preview: While adding the props a preview is created of how the prop will be placed on the part, 

as shown in Figure 7.33. 

 

Figure 7.33 Preview of adding prop 

7.7 Label 

By using the Label function, you can merge the text into the part. 
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Select the part, and click the “Label” command in the Home menu, or press the shortcut keys 

Shift + L, A dialog box for setting parameters will pop up, as shown in Figure 7.34. 

 

Figure 7.34 Label part setting 

Under the Text tab, you can add the text directly, or click the “Part Name” button to use the part 

name as the added text. Click the “Change Font” button can change the text font and size.  

In the Setting tab, you can select the texture direction, that is, the outside surface or the inside 

surface, and set the depth of the texture. 

The added text will be displayed in the screen with the original part, and you can hold down the 

mouse wheel to move the part to reach the desired label effect. Finally, click the “OK” to 

complete the label. 

In the Controls tab, click “Translate text” to move the text to the appropriate position, and click 

“Center text” to move the text to the center of the part. Besides, you can use the mouse to move 

the part so that the text is placed in the appropriate place on the part. 

The effect of adding the text "Voxeldance" on the part is shown in Figure 7.35. 
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Figure 7.35 Add label 

7.8 Boolean Operation 

7.8.1 Boolean Operation 

The Boolean operation module provides three Boolean operations for the part, including merging 

part, extracting overlapping portions, and removing overlapping portions from the part. 

To conduct the Boolean operation, firstly you should move the parts (at least two) together to 

overlap each other, that is, each part does not exist independently. Select all parts you want to 

use, click the “Boolean” command in the Boolean drop-down menu under the Home menu, or 

press the shortcut keys Ctrl + B, to open the Boolean operation setting dialog, as shown in Figure 

7.36. 
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Figure 7.36 The Boolean Operation setting 

There are A and B operating areas in the dialog, and the part in area A is purple, and the part in 

area B is orange. Users can adjust the operating area of each part by pressing the “to right” and 

“to left” buttons; users can also switch the parts of the two regions via the switch key, but each 

area must contain at least one operating part. After the adjustment, you can perform three 

Boolean operations for the part in the A, B regions respectively: 

(1) Union: All parts of the two operating areas are merged, as shown in Figure 7.37.  

 

Figure 7.37 Union operation 

(2) Intersect: Extracting the parts of the two operating regions where the parts overlap each 

other, as shown in Figure 7.38. 
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Figure 7.38 Intersect operation 

(3) Subtract 

a) Subtract B from A: Combine all parts in area A, but remove the part that overlaps the part in 

B region, as shown in Figure 7.39. 

b) Subtract A from B: Combine all parts in area B, but remove the part that overlaps the part in 

A region. 

 

Figure 7.39 Subtract operation 

If you check the "Multiple Boolean Operations" option on the Boolean operation tab, you can 

perform multiple Boolean operations at the same time and specify which Boolean operations to 

use. This option is OFF by default. 

If you select the "Remove original part" option on the “Controls” tab, you cannot keep the original 

part. 

7.8.2 Merge Parts 

Select two or more parts, and use the "Merge Parts" command in the Boolean drop-down menu 

under the Home menu to merge them into one part. The merged part contains the entire shell 

of the selected part, as shown in Figure 7.40. Clicking this "Merge Parts" command will pop up a 

dialog asking if you want to keep the original part. 
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Figure 7.40 Merge parts 

7.8.3 Shells to Parts 

If the selected part contains more than one shell, each shell can be split into independent parts 

through the "Shell to Parts" command in the Boolean drop-down menu under the Home menu, 

as shown in Figure 7.41. Clicking this command will pop up a dialog asking if you want to remove 

the original part. 

 

图 7.41 Shell to parts 

7.9 Structure 

The Structures Module enables you to swiftly make complex structures within a certain part. 

These structures allow you to reduce the consumption of material and weight of the part, without 

losing strength. The Structures wizard will guide you to through a few steps in order to hollow 

the part, and fill them with lightweight structures. And you can easily add holes to allow the 

powder to escape. 



87 

 

Select the part, and click the “Structure” command under the Home menu, the parameters 

setting dialog for creating structure will pop up in the display window, as shown in Figure 7.42.  

 

Figure 7.42 Create structure setting 

The parameter setting dialog consists of three main steps: define Outer Shell、choose Structure、

add Drain Holes. In the definition of the shell operation, you can choose “No Outer Shell” or 

“Outer Shell”. If you select “No Outer Shell”, structure will be completely replaced by lattice, no 

shell; if you select “Outer Shell”, the part will add the shell firstly, then add the lattice in the 

internal structure, and the part has a shell after structure (Part hollow refer 7.2.1).  

When the “Outer Shell” operation finishes, click Next to enter the “Structure” operation, such as 

figure 7.43. 
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Figure 7.43 Choose structure setting 

There are 9 structural types and corresponding structure preview provided at the top of the 

“Choose Structure” settings page. The corresponding parameters in the middle part are 

explained in Table 7.9. 

Table 7.9 Choose Structure parameter settings 
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Structure Dimensions Set the length in X, Y, and Z of the unit structure 

Strut Radius The radius of the structural strut 

Cross Section  The number of cross section of structural struts 

Keep Aspect Ratio 
If selected, the Y and Z length will be rescaled uniformly with 

the X length 

Invert Structure After selection, the surface of the lattice structure is inverted 

The “Advanced Options” setting provides some advanced settings. The corresponding parameter 

settings are explained in Table 7.10. 

Table 7.10 Advanced Options parameter settings 

Spacing：Spacing between cell structure bounding boxes 

                            

dx=0mm                                 dx=5mm                                  dx=10mm 

Start Position：The start position of structure can be defined 

                              

                   dx=0mm                              dx=12mm                                dx=25mm 

Angled Growth：Generating lattice at a specified angle 
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                      X=0°                                        X=10°                                             X=20° 

After the “Structure” operation finishes, you can add the lattice to the part and enter the “Drain 

Holes” operation by clicking the Next button, as shown in Figure 7.44. 

  

Figure 7.44 Add drain holes setting 

In the Add Drain Holes operation, a hole can be added in the part body (See 7.5 for the Perforator 

operation).  
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After the perforator operation finish, click “Finish” button to complete the structure. 

 

Figure 7.45 Create structure effect  

7.10 Z-Compensation 

In the actual printing process, the machine may cause the thickness of the first printing layer 

higher than other layers. That is, the bottom of the Z-axis may stretch, causing the deformation 

of the entire printed part. This effect can be eliminated by the Z compensation function.  

Select the part, and click the “Z-Compensation” command in the Home menu, and the Z-axis 

compensation parameter setting dialog will pop up, as shown in Figure 7.46.  
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Figure 7.46 Z compensation setting  

If "All Parts" is selected, Z compensation will be performed for all parts on the platform. If 

"Selected Parts" is selected, Z compensation will be performed only for the selected parts. 

The user should set the first-layer Z-axis height in the Z-Height compensation adjustment box 

according to the characteristics of the printer used, and the bottom layer thickness of the part 

will be adjusted to that value. 

Triangle based: This algorithm will detect all downward facing triangles and move them in the Z 

direction by a distance determined by the input Z compensation value. 

Point-based: The algorithm will detect all downward facing triangles and move the points of these 

triangles in the Z direction by a distance determined by the input Z compensation value. 

Moreover, by checking the "Use Angle based Correction factor" checkbox, you can set 

compensation parameters according to the different angles between the bottom of the part and 

the platform. If you click the reset button, the compensation parameters of each angle will 



93 

 

restore the default values. After all the settings, click the Confirm button to complete the 

operation, the effect is shown in Figure 7.47. After the Z-axis compensation is performed, the 

updated Z-axis coordinates will be displayed in the Box property under the Basic Info page. 

 

Figure 7.47 Z-Compensation 
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8 Part Repair 

 

Figure 8.1 Part Repair menu 

Any damaged part can’t be used for printing, and you can repair it with the repair module. Select 

the part, and click the “Fix Module” command in the Home menu or the Modify menu, or the 

shortcut keys Shift + R, will enter the repair mode and the selected part will be displayed in the 

triangular mesh mode. Meanwhile, the Repair Part control page will open at the left part of the 

interface, as shown in Figure 8.2  

 

Figure 8.2 Repair mode interface 

The Repair Part page is mainly divided into four functional sub-pages such as Error list, 

Information, Shells and Holes. Errors List area lists each type of damage and the exact location of 

each damage. The Information area mainly shows the part information and damage information, 
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including Vertices, Triangles, Shells, N-manifolds, Bad edges, Holes, Bad orientation, Intersections. 

After each operation, you can update the above information by clicking the “Update” button 

below the info area. If the “Auto Update” checkbox is checked, the part status is automatically 

detected and updated. Shells page displays shell information. Holes page displays hole 

information. 

8.1 Automatic Fix 

 

Click the "Automatic Fix" command in the Home menu or the Modify menu, or in the Fix module, 

you can perform automatic repair for the part. 

After the repair is completed, without entering the repair module, you can perform the error 

check of the repaired part by modifying the "Check Errors" command under the Modify menu. 

Click this command, Check Errors dialog will pop up in the display window, as shown in Figure 8.3, 

the display content of this dialog is consistent with the content of the information displayed in 

the Information area under the repair module, including Vertices, Triangles, Shells, N-manifolds, 

Bad edges, Holes, Bad orientation, Intersections. Click the “Update” button at the bottom of the 

dialog to begin to check the errors on the part. 
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Figure 8.3 Check error 

8.2 Semi-Automatic Repair 

 Semi-automatic repair is usually targeted for specific damage or error type. Enter the repair 

module, the corresponding menu is shown in Figure 8.4. 

 

Figure 8.4 The semi-automatic repair menu 

8.2.1 Fix Normals 

In an STL-file, the outside of a triangle is defined. For further processing/slicing of the STL-file, it’s 

important that the outside is defined correctly, if not, these flipped triangles must be inverted. 

8.2.2 Stitch Triangles 

When a gap (hole) exists between adjacent triangles, the adjacent vertices and edges can be 

connected with the Stitch Triangles function, thereby forming new triangles and stitching the 

voids. 

Click the “Stitch Triangles” button, a dialog for setting Tolerance will pop up. It allows you to set 

the maximum spacing of the triangles to be stitched, thus preventing the part distortion caused 

by stitching. The stitching effect as shown in Figure 8.5. 

   

Figure 8.5 Before stitching (Left) and after stitching (right)  
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8.2.3 Close Holes 

By clicking the “Close Trivial Holes” button, individual triangles can be inserted directly and 

appropriately into all the simple polygon holes in the part to get them closed. By clicking the 

“Close All Holes” button, all holes in the part are closed. Although this is the most straightforward 

way to repair holes, it may not achieve the best repair effect when dealing with complex holes 

associated with the part structure or direction.  

In addition, detailed information about each hole is displayed under the Holes area in the left 

part of the interface, including the number of edges and the perimeter. After clicking on any item 

in the list, you can select the corresponding hole, marked with red borders, and it can be observed 

on the display graphics, as shown in Figure 8.6. Once selected, it can be closed after you click the 

Fix selected button below the list, and the corresponding item will be removed from the list. 

    

Figure 8.6 Holes page and holes selection 

8.2.4 Remove Noise Shells 

Some shells are just noise and make no geometrical sense. It's easier to fix the part when they 

are removed in an early stage of fixing. Click the “Remove Noise Shells” button, all noise shells in 

the part will be removed. 
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And the Shells area shows the details of each shell, including the number of triangles, area and 

volume, and. By clicking on any item in the list, you can select the corresponding shell, which is 

marked as yellow, and it can be observed on the display graphics, as shown in Figure 8.7. Once 

selected, the shell will be deleted after you click the Delete selected button below the list, and 

the corresponding item will be removed from the list. By clicking the Delete noise button below 

the list or the Delete Noise Shell button in the Action sub-page, you can delete all the noise shells 

directly and leave only the main shells. 

 

Figure 8.7 Shells page and shells selection 

8.2.5 Remove Intersections 

The fix intersection area provides the operations of Detect Intersection, Split Intersection, and 

Fix Intersection. 

In the information area on the left, check the “Intersections” option, and then click “Update” 

button. If a non-zero number of intersections is displayed, it indicates that there is a self-

intersection in the part. Click the “Detect Intersection” button, the intersection lines will be 

marked red on the part. Click the “Split Intersections” button, the intersection surface will be cut 

off / stripped along the dividing lines, producing some Non-Manifolds. After clicking the "Fix 

Intersections" button, all the internal shells and the overlapping surfaces will be removed and 

the outer surfaces will be connected to each other to form a single shell, as shown in Figure 8.8. 

The Fix operation should be done with no holes on the part or after all holes are repaired. 
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Figure 8.8 Self-intersecting before (left) and after the repair (right) 

8.2.6 Delete Sharp Face 

When parts have thin triangles, this function is to deletes them. Click the "Delete Sharp Triangle" 

button, and the setting dialog will pop up, as shown in Figure 8.9. 

 

Figure 8.9 Remove sharp triangles setting 

Max width: Triangles smaller than this distance will be marked or deleted, depending on your 

choice 

Angle: The thin triangle will only be selected when the angle it makes with its neighbours is bigger 

than the given angle. This is easy to filter only thin triangles of folds and leave thin triangles of 

curves untouched.  

Collapse: The thin triangle will be removed and its neighbours will be connected to each other.  

Delete triangles: The thin triangles will be deleted, bad edges will appear  
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Mark triangles: The thin triangles will be marked.  

8.2.7 Delete Double Face 

Click the “Delete Double Faces” button, all the overlapping triangles or overlapping faces in the 

part will be removed. After this operation is executed, the updated number of triangles will be 

displayed in the Information field. 

8.2.8 Wrap Outer Faces 

By clicking the “Wrap Outer Faces” button you can remove all meshes or shells inside the part 

and leave only the outer surface of the part. This function is typically used to remove the inner 

shells of the part. 

8.2.9 Resolve Overlaps 

Under the Modify menu, click the “Resolver Overlaps” button. A dialog will pop up to set the 

tolerance value, that is, the maximum distance to repair the overlap. After setting, it can be 

executed to repair the triangles that touch, overlap, or close to each other in the part as single 

plane or shell. 

8.2.10 Create Bridge 

Under the Modify menu, click the "Create Bridge" button, and then select the two contour lines 

on the part where in between a bridge needs to be created. A preview is shown of the bridge 

before creation. This function is used to help fixing complex holes. 

8.3 Manual Repair 

8.3.1 Add a New Triangle 

When a small number of missing triangles or holes exist, click the "Add a New Triangle" button 

to enter the vertex selection state. In this mode, when you select any vertex, a red circle and a 

number will appear on the vertex to indicate that it is selected. After three vertices are selected, 

a new triangle will be added, as shown in Figure 8.10. 
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Figure 8.10 Add a triangle manually 

8.3.2 Delete Marked 

When a mark currently exists, click the "Delete Mark" button or select the "Delete Mark" triangle 

command from the right-click menu of any triangle, you can delete the marked triangle 

8.3.3 Flip Marked 

When a mark currently exists, click the "Flip Marker Triangle" button, or select the "Flip Marker 

Triangle" command from the right-click menu of any triangle, the marked triangle will be flipped. 

8.4 Manipulation 

8.4.1 Mesh Subdivision 

When the file is too small or the accuracy of the part is too low, you can increase the number of 

triangles by subdividing the triangles to improve the accuracy of graphics. After selecting the part, 

click the “Mesh Subdivision” command under the Modify menu, and the parameter setting dialog 

of the subdivision operation will pop up, as shown in Figure 8.11. 
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Figure 8.11 Mesh subdivision setting 

If you select “All selected parts”, the corresponding mesh operation will be performed on the 

whole part. If you select “Only marked triangles”, you need to select an area on the part where 

the corresponding operation will be performed.  

The user can set the minimum length of the triangle edges through the min length spin-box and 

thus limit the number of triangles by limiting the size of the triangles. he iteration adjustment 

box is used to set the number of iterations, that is, the number of times to perform the 

subdivision operation repeatedly. When the iteration value is larger, the number of subdivided 

triangles increases exponentially. By checking the “Keep structure” checkbox below, you can 

also perform the subdivision process without changing the original structure of the part. In the 

case of " Only marked triangles", "Subdivide marked border" can be edit. If checked, it means 

that the boundary of the selected triangle will also be subdivided. 

After the part is subdivided, the updated number of triangles will be displayed in the Part Details 

field on the left of interface. 

8.4.2 Mesh Reduction 

When the file is too large or the part is too complicated, you can merge triangles with mesh 

reduction function to reduce file size or speed up calculations. After selecting the part, click the 

"Mesh Reduction " command under the Modify menu, or the shortcut keys Shift + T, a parameter 

setting dialog for the operation will pop up, as shown in Figure 8.12. 
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Figure 8.12 Mesh reduction setting 

If you select “All selected parts”, the corresponding mesh operation will be performed on the 

whole part. If you select “Only marked triangles”, you need to select an area on the part where 

the corresponding operation will be performed.  

Maximum deformation: If 2 triangles are replaced by one triangle, there may be a little 

deviation in position. The tolerance indicates the maximum deviation allowed between the 

original surface and the new one.  

After the part is reduced, the updated number of triangles will be displayed in the Part Details 

field on the left of interface. 

8.4.3 Remesh 

When the part has a lot of irregular meshes, you can refactor smoother triangles through the 

Remesh function. After selecting the part, click the “Remsh” command in the Modify menu, and 

the Remesh setting dialog will pop up, as shown in Figure 8.13. In the setting box, the tolerance 

represents the maximum value of the mesh surface deviation distance before and after 

remeshing, and the lower this value is, the more similar to the original part and the finer the 

triangle mesh will be, and the larger this value is, the surface is simpler. The minimal length and 

the maximal length represent the shortest and longest sides of the reconstructed triangle, and 

the dihedral angle means that the triangle whose angle is greater than this value in the original 

part will retain its feature.  
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Figure 8.13 Remesh setting 

8.5 Mark Triangles 

The function of marking triangles exists in the toolbar by default. 

 

To repair the damaged STL file, the user can mark the triangles of the selected part. You need to 

select the part before marking the triangle. The selected triangle is marked (default) yellow on 

the part. 

1) Mark single triangle: Triangles can be marked one by one. Marked triangles can be 

unmarked by indicating them with the Mark single triangle cursor again. 

2)  Mark Plane: By clicking one triangle, a whole plane can be selected or unselected. 

3)  Mark Surface: By clicking one triangle, a surface can be selected or unselected. 

4)  Mark Window: Click this icon, you can mark all triangles within a rectangular area.  

5)  Mark Shell: A single shell is marked by clicking on any triangle in the shell. Click the 

triangle again to unmark it. 

6)  Mark Brush: Click this icon, you can draw a path on the part to mark all the passed triangles. 

7)  Mark Freedom: Click this icon, you can draw a curve on the part to mark all the triangles 

inside. 
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8)  Mark Polygon: Click this icon, you can draw a polygon on the part to mark all the triangles 

inside. 

9)  Mark Polygon and Remesh: Click this icon, you can draw a polygon on the part to mark 

the triangles inside, and at the same time, the triangular face on the edge of the polygon is 

remeshed. 

10)  Mark Circle and Remesh: Click this icon, you can draw a circle on the part mark the 

triangles inside, and at the same time, the triangular face on the edge of the circle is remeshed. 

11)  Mark Ellipse and Remesh: Click this icon, you can draw an ellipse on the part to mark the 

triangles inside, and at the same time, the triangular face on the edge of the ellipse is 

remeshed. 

12)  Unmark All：All triangles will be unmarked. 

13)  Expand Marked: The group of selected triangles will become bigger. All unmarked 

triangles lying next to a marked triangle will be marked. 

14)  Shrink Marked: The group of selected triangles will become smaller. All triangles lying at 

the border of the group will be unmarked. 

15)  Invert Marked:  Click this icon, you can invert the marked triangles, all unmarked triangles 

turn yellow (or the defined marked triangle color) and vice versa. 

16)  Delete Marked: The marked triangles are deleted. 

17)  Separate Marked: The marked triangles are separated from the original part and stored 

in a separate part. 

18)  Copy Marked: The marked triangles are copied; and a new part is created in the part list. 

19)  Flip Marked:  Flip the normal of the marked triangle. 
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20)  Invert Part:  Flip the normal of all triangles. 

21)  Hide Marked:  The marked triangles are hidden. 

22)  Invert Triangles Visibility:  Make invisible triangles visible and vice versa. 

23)  Unhide All:  Make all triangles visible. 
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9 Support Operation 

 

Figure 9.1 Support Generation menu 

The part needs to be added support structure before printing, there are five main types of 

support: point support, bar support, line support, volume support and smart support, as shown 

in Figure 9.2.  

           

         

Figure 9.2 From top to bottom, from left to right: point support, bar support, line support, volume support 

and smart support 

9.1 Support Module 

After selecting the part that is undamaged or has been repaired, then clicking the “Support 

Module” command in the Support Generation menu, or pressing the shortcut keys Shift + I, users 

can enter the support operation module. 
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Figure 9.3 Support Module menu 

9.1.1 Automatic Support 

Many parts do not only contain one support area, and may contain many unconnected support 

areas. Automatically supporting the entire part or each support area can be completed in one 

step. 

In the current support module, there are three default predefined scripts for creating automatic 

support: DLP (for Bar support), SLM (for Line support and Volume support) and smart support, 

and they perform support operations in a predetermined order. After entering the support 

module, the following operation page will appear in the left lower part of the interface, as shown 

in Figure 9.4. 
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Figure 9.4 Default support script 

In this operation page, you can customize, edit and save new support scripts. The above drop-

down menu shows the used script, and you can create a new script by clicking the “ ” icon 

button. If you want to delete the added support script, you can click “ ” icon button to delete, 

and if you want to set the default script, import/export script, you can click “ ” icon button to 

set. The default DLP, SLA and Smart cannot be edited and deleted. 

The following attribute area shows the script order in which the support is executed. Some of the 

functions in the script have a sign  on the left, and you can open, view and edit the detailed 

parameters of these functions by clicking it. When the mouse is hovered over each parameter 

name, a graphical explanation of the parameters will pop up, as shown in Figure 9.5. 

 

Figure 9.5 The graphical explanation of the Surface angle parameter 
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Currently, you can add two three script types, including bar support, block support and smart 

support, as shown in Figure 9.6. Select a support type, set the name and click "Confirm" to add 

its function parameters to the current script. Click "Save" button to save the added new script 

settings to this program. 

 

Figure 9.6 Add new support script  

Select a support script, set the required parameter values, and click "Generate support" to 

complete the automatic addition of the support structure, and at the same time, the support 

region boundary contour line will be formed at the support boundary. If the “Only marked surface” 

selection box is checked, support is only generated in the marked area, as shown in Figure 9.6. 

 

Figure 9.6 Generating support in marked area 

After adding the appropriate support, click the “Exit Support” in the menu, a query operation 

dialog will appear. If you click "Apply Operation” button, the support structure will be added to 

the part and the support module is exited; if you click "Discard changes" button, the part will be 

restored to the one before entering this module, and the support module is exited. 

A detailed description of the bar support and block support is shown in Tables 9.1, 9.2 and 9.3. 

Table 9.1 Bar support settings 
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Attributes Meaning 

General  

Surface angle 

The angle between the support surface and the horizontal plane 

The larger the critical angle, the greater the area that needs to be 

supported 

Anchors distance Define the distance between internal anchor points 

Border anchors distance Define the distance between border anchor points 

Border offset The distance from support to the support area boundary  

No support offset Overhangs less than this offset value will not generate support 

Distance in part The length of the support bar inserting into the part 

Trunk  

Top width The width at the top of the support bar 

Top Ball Contact Whether the top of the support bar is spherical 

Middle Width The width at the middle of the support bar 

Bottom width The width at the bottom of the support bar  

Tip length 

Distance between part surface and contact point widened to 

middle width 

Tip type Direction of support contacting parts 

Bar edge number The number of the support bar 

Cross type The cross type between two support bar  

Base Whether to generate a support base 

Base offset 

Relation to the base type, if the base is convex hull and the 

minimum area, it is the distance between the support point and 

the base boundary; if the base is rectangular, it is the distance 

between the base border and the critical bounding box 

Base height 
The thickness of the base 



112 

 

Table 9.2 Block support settings 

Attributes 
Meaning 

General  

Surface angle 

The angle between the support surface and the horizontal plane 

The larger the critical angle, the greater the area that needs to be 

supported 

Border offset 
The distance between the support and the support area 

boundary 

No support offset Overhangs less than this offset will not be supported 

Vertical wall offset The distance support and the vertical plane 

Distance in part The length of the support bar inserting into the part 

Perforation 
Whether to generate a diamond-shaped structure on the internal 

support 

Solid Height Boundary thickness in the diamond area 

Hole width The right and left heights of the diamond structure 

Diamond angle The angle of diamond edge and horizontal diagonal  

Beam witch Diamond outer thickness 

Remove Overhang Perforation 

Whether to remove holes with overhanging edges (complete 

holes are diamond-shaped. If the sides of incomplete holes have 

horizontal edges, then this edge is an overhanging edge, and this 

hole is an overhanging edge) 

Border Perforation 
Whether to generate a diamond-shaped structure on the border 

support 

Base type 

The support base type has three types: rectangle, convex hull 

and minimum area. 

Rectangle: The projection of the part’s bounding box in the XY 

plane as the base; minimum area: The minimum base that 

connects each support base; convex hull: The convex shape 

composed of each support bar as the base 

Circle Base Support base with the minimum area 

Circle radius The radius of the support base with the minimum area 
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Solid Height Boundary thickness in diamond area 

Hole width The right and left heights of the diamond structure 

Diamond angle The angle of diamond edge and horizontal diagonal  

Beam witch Diamond outer thickness 

Remove Overhang Perforation 

Whether to remove holes with overhanging edges (complete 

holes are diamond-shaped. If the sides of incomplete holes have 

horizontal edges, then this edge is an overhanging edge, and this 

hole is an overhanging edge) 

Teeth (Upper)  

Top width The top width of teeth in the upper support  

Base width 
 

The base width of teeth in the upper support 

Height The height of the teeth in the top support 

Base interval The spacing between the teeth in the upper support 

Teeth (Lower)  

Same as upper teeth Using the same parameters value for upper and lower teeth 

Top width The top width of teeth in the lower support 

Base width The base width of teeth in the lower support 

Height The height of the teeth in the lower support 

Base interval The spacing between the teeth in the lower support 

Is filling  

Hatching Whether the filling line is added to the support 

X hatching Filling line space in the X axis direction 

Y hatching Filling line space in the Y axis direction 

Rotate angle The angle of X-axis fill line and horizontal  

Fragmentation Whether to fragment on the support area  

X interval The width of the x-axis interval after adding interval support 

Y interval The width of the y-axis interval after adding interval support 
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Separation Width The width between intervals 

Divide support block Whether to generate support blocks 

 

Table 9.3 Smart support settings 

Attributes Meaning 

General  

Surface angle 

The angle between the support surface and the horizontal 

plane 

The larger the critical angle, the greater the area that needs to 

be supported 

Anchors distance Define the distance between internal anchor points 

Border anchors distance Define the distance between border anchor points 

Border offset The distance from support to the support area boundary  

No support offset Overhangs less than this offset value will not generate support 

Distance in part The length of the support bar inserting into the part 

Diamond  

Diamond width The right and left heights of the diamond structure 

Diamond angle The angle of diamond edge and horizontal diagonal  

Edge width Diamond outer thickness 

Margin to part Distance from support structure to part edge 

Column height to width ratio 

Represents the number of diamonds in a column before 

expanding the grid 

Teeth  

Top width 
The width of the contact point between the support and the 

part 

Base width 

The width of the support leading to the contact point of the 

part 
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Height 
Distance between part surface and contact point widened to 

connection width 

9.1.2 Manual Support 

With clicking the "Edit Point Supports" icon , the corresponding point support attributes will 

appear in the support operation page in the left side. You can create an anchor point by clicking 

any point on the lower surface of the part, its size can be adjusted by the anchor radius scroll bar 

in the right setting. After adding any anchor point, you can delete the anchor point by clicking 

the left mouse button at the anchor point; you can move the anchor point by selecting anchor 

point and dragging the left mouse button to change the anchor point position. After creating an 

anchor point, you can add a point support structure at the anchor point. And the property of “Rib 

Num” is to define the number of ribs that make up the Point support. 

With clicking the "Edit Bar Supports" icon , the corresponding bar support attributes will 

appear in the support operation page in the left side. You can create an anchor point by clicking 

any point on the lower surface of the part, its size can be adjusted by the anchor radius scroll bar 

in the right setting. After adding any anchor point, you can delete the anchor point by clicking 

the left mouse button at the anchor point; you can move the anchor point by selecting anchor 

point and dragging the left mouse button to change the anchor point position. When you create 

at least one anchor point, then click right-click the mouse, a bar support structure at the created 

anchor point can be added. 

With clicking the "Edit Line Supports" icon , the corresponding line support attributes will 

appear in the support operation page in the left side. You can create an anchor point by clicking 

any point on the lower surface of the part, its size can be adjusted by the anchor radius scroll bar 

in the right setting. After adding any anchor point, you can delete the anchor point by clicking 

the left mouse button at the anchor point; you can move the anchor point by selecting the anchor 

point and dragging the left mouse button to change the anchor point position. When you create 

at least two anchor points, then right-click the mouse, a line support structure at the created 

anchor point can be added. In this support structure, if you select the anchor point and drag the 
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left mouse button to any position, the line support structure will be updated in real-time. And if 

you hold Ctrl button when selecting the anchor point and drag the left mouse button, the real-

time update of the line support structure is not executed, until you release the Ctrl button, the 

line support structure will be updated. This operation can adjust the line support structure of 

multiple anchor points faster. 

With clicking the "Edit Volume Supports" icon , the corresponding volume support attributes 

will appear in the support operation page in the left side. You can create an anchor point by 

clicking any point on the lower surface of the part, its size be adjusted by the anchor radius scroll 

bar in the right setting. After adding any anchor point, you can delete the anchor point by clicking 

the left mouse button at the anchor point; you can move the anchor point by selecting the anchor 

point and dragging the left mouse button to change the anchor point position. When you create 

at least three anchor points, then right-click the mouse, a volume support structure at the 

created anchor point can be added. In this support structure, if you select the anchor point and 

drag the left mouse button to any position, the volume support structure will be updated in real-

time. And if you hold Ctrl button when selecting the anchor point and drag the left mouse button, 

the real-time update of the volume support structure is not executed, until you release the Ctrl 

button, the volume support structure will be updated. This operation can adjust the volume 

support structure of multiple anchor points faster.  

With clicking the "Edit Smart Supports" icon , the corresponding bar support attributes will 

appear in the support operation page in the left side. You can create an anchor point by clicking 

any point on the lower surface of the part, its size can be adjusted by the anchor radius scroll bar 

in the right setting. After adding any anchor point, you can delete the anchor point by clicking 

the left mouse button at the anchor point; you can move the anchor point by selecting anchor 

point and dragging the left mouse button to change the anchor point position. When you create 

at least one anchor point, then click right-click the mouse, a smart support structure at the 

created anchor point can be added. 
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After clicking the "Select Support" icon , you can select the support in the area by clicking any 

point in the support region boundary contour line. After clicking the "Select Polyline" icon , 

you can select a single support polyline, and clicking it again will deselect it. After you click the 

“Select Item” icon , you can select a single support item, and clicking it again will deselect it. 

And with clicking the "Delete selected supports" icon , you can delete the selected support, 

and you can also remove the selected supports and all supports in the right-click menu.  

After selecting a contiguous support, and clicking the "Show Select" icon , the unselected 

support of the part is hidden, and only the selected support area is displayed. Click the "Hide 

Parts" icon , the parts are hidden and only the supports are showed. Click the “Support 

Surface” icon , and a preview of the support area will be displayed according to the settings 

in the dialog. 

In the above operation, after clicking an icon in the edit support, the mouse will carry the 

corresponding icon. During the execution of this function, the mouse will always carry the icon 

until it switches to other functional operation icons. 

9.1.3 Edit Support 

After entering the support module, the support list tab page is automatically added in the Part 

View. The added tree support, point support, line support, block support and smart support are 

displayed in the Support List, as shown in Figure 9.8. Double-click on a support in the Support List, 

the support will be selected to enter editable state. 
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Figure 9.8 Support List  

In the Edit tab, you can edit the selected support with common settings and advanced settings.  

Under the common setting tab, you can change the support type of the selected support. After 

selecting a support, the support type automatically jumps to the support type of it, as shown in 

Figure 9.9. Under the support type, you can change the relevant parameters in the attribute 

settings, click the "Regenerate" button to regenerate the support with the support type; you can 

also select another support type in Support Type list, and set the parameter, then click the 

"Regenerate" button to implement the type conversion of the selected support, “None” 

indicates that there is no support in support area. 

 

Figure 9.9 Matching the support type with the selected support 
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Under the Advanced settings tab, you can set the angle support and scale support for the selected 

support. 

1) Angle Support Settings 

For point support, line support and block support structures, if the bottom of the support is on 

the top surface of the part, to protect the part surface from being damaged, the support position 

can be changed by adjusting the support angle so that the support can fall on the platform as 

much as possible.  

After adding the corresponding support, clicking the "Select Support" in the menu, and then 

select a section of the connected support. In the advanced settings in the Edit tab, check the 

“Angle support” selection box and click the “Interactive” button to add the direction manipulator 

in the support, as shown in Figure 9.10. In this mode, you can drag the support in the 

corresponding direction by moving the mouse to any axis (X, Y or Z) or any coordinate plane (X-

Y, X-Z or Y-Z). If you check on “Auto generate”, the support will be automatically regenerated 

after dragging; if not, you are request to click “Regenerate” button to regenerate the support. If 

you check on “Show current support” the current support is showed during the dragging; if not, 

the current support is hide, and only the moving shade is showed. 

 

Figure 9.10 Move support 

2) Scale Support Settings 
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For point support, line support and block support structures, the support is stronger only if the 

bottom of the support is wider than the top. In order to get a more solid support structure, the 

bottom support can be made wider by scaling the bottom support to change the support size. 

After adding the corresponding support, you can click the "Mark Support" in the menu, and then 

select a section of the connected support. In the advanced settings in the Edit tab, check the 

“Scale support” selection box and click the “Interactive” button to add the support scale mode 

of the control direction in the support, as shown in Figure 9.11. In the scale mode of the control 

direction on the support, you can scale the support in the corresponding direction by moving the 

mouse to any axis (X, Y) or X-Y coordinate plane. If you check on “Auto generate”, the support 

will be automatically regenerated after scaling; if not, you are request to click “Regenerate” 

button to regenerate the support. If you check on “Show current support”, the current support 

is showed during the scaling; if not, the current support is hide, and only the scaling shade is 

showed. 

 

Figure 9.11 Scale support 

In addition, in the Edit Support tab, 2D editing dialog can be opened by clicking “2D Edit” button, 

and support structure can be changed by editing. In 2D editing, you can do the operation of 

adding point support, line support, enhance support, and rectangle deletion and polygon 

deletion, flip view, zoom to select, zoom to selected part, as shown in Figure 9.12. Supports added 

in 2D Edit are also displayed in the Support List. 
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Figure 9.12 2D Edit dialog 

About the detailed parameters in the 2D edit dialog, as shown in Table 9.4. 

Table 9.4 2D Edit Parameters  

 
Draw a point support 

 
Draws one cross line support 

 
Draws a reinforcement line 

 

Click and drag on the 2D image. All selected supports in Support List and 

inside the window selection will be removed 

 

Draw points on the 2D image. Click the right mouse button to exit the 

command. All selected supports in Support List and inside the polygon 

selection will be removed 

 

Switch top and bottom view 

 
Zoom in the selected area 
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Zoom to selected part 

9.1.4 Import Supports 

Under the support module, after clicking the “Import Support” command , the file selection 

path box will pop up, and you can select the appropriate STL file as a support to import to the 

support module. 

9.2 Quick support script  

After setting the default support script, and selecting the part, you can directly add support to 

the selected part by clicking the “Support Script” command in the Support Generation menu, or 

pressing the shortcut keys Ctrl + Shift + I, without entering the support module, or selecting the 

corresponding run script in the drop-down menu of the Support Script command. 

9.3 Refresh Attached Support 

When moving the part with support, a prompt dialog will pop up, as shown in Figure 9.13. After 

the part is moving to the final position, then click the “Refresh” command in the Support 

Generation menu, the support will be adaptively updated with the height of the part, as shown 

in Figure 9.14. 

 

Figure 9.13 Prompt dialog 
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 Figure 9.14 Move the part with support 

When scaling the part with support, a prompt dialog will pop up, as shown in Figure 9.13. After 

the part is moving to the final size, then click the “Refresh” command in the Support Generation 

menu, the support will be adaptively updated with the size of the part, as shown in Figure 9.15 

                                                                            

Figure 9.15 Scale the part with support 

After the part is added with support, click the part placement icon  in the toolbar to enter the 

part movement mode of controlling direction, then move the mouse to the yellow circle in the z-

axis direction and rotate, the part with support can be rotated, as shown in Figure 9.16. 
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Figure 9.16 The rotation around Z direction of the part with support 

9.4 Unload Supports 

After selecting one or more parts with supports, then clicking the “Unload” command in the 

Support Generation menu, you can remove the support. 

9.5 Export Supports 

After selecting one or more parts with supports, then clicking the “Export” command in the 

Support Generation menu, the Export Support operation settings dialog box will pop up, as 

shown in Figure 9.17. Click the icon “ ” to set the file save path, and select whether to export 

it as an STL file including the part.  
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Figure 9.17 Export support operation settings 

9.6 Assign Part as Support 

This operation can add any selected part as a support to another part. After selecting one or more 

parts that need to be designated as supports, click the “Assign as” command in the Support 

Generation menu, then click the part on the platform that needs to be supported, the part that 

has been designed as support is added to the part, and the support part is displayed as yellow, 

as shown in Figure 9.18. 

 

Figure 9.18 The effect of assigning the part as support 

9.7 Supported Area Preview 

Before generating your support, you can in advance visualize the areas that would need support. 

Click the “Supported Area” command under the Support Generation menu, the support area 

preview settings dialog will pop up, as shown in Figure 9.19. 

Enter the surface angle value directly, you can adjust the size of the support area, and the support 

area is displayed in yellow; Check the “Highlight down-facing edges” option to highlight the 

lowest line of the part; When checking the ‘Show support preview’ checkbox, a preview of the 

support is displayed, as shown in Figure 9.20. At the same time of the preview, you can change 

the surface angle or re-position your part based on the analysis of the surfaces and edges. Check 

the “Clear the marked area while closing” option, the marked support area in yellow will be clear 

when closing the dialog box, and if this option is not checked, the marked support area in yellow 

will still be displayed on the part after the dialog is closed.  
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Figure 9.19 Support area preview settings 

 

Figure 9.20 Support area preview  

9.8 Add No-Support zones 

It is difficult to add support on the surface of some parts, and it increases the difficulty for 

subsequent post-processing operations. In this case, it may be preferential to prevent supports 

from being generated in these areas, especially when achieving a higher quality surface finish 

requirement outweighs a possible deformation due to lack of supports. 

The steps to create an unsupported area are as follows: 

1. Mark the triangle area on the part where no support is added. 

2. Click the “Add No-Support” command in the Support Generation menu, the no-support zones 

are displayed in orange, as shown in Figure 9.21. 
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Figure 9.21 No-support zones are shown in orange 

9.9 Enable No-Support zones 

The “Enable No-Support” command in the Support Generation menu is enabled by default. If it 

is not enabled, click this command to enable it, and support will not be generated in the 

unsupported area when performing quick support operation or automatically adding support in 

the support module. If not enabled, support will still be generated in the unsupported area when 

adding support, as shown in Figure 9.22. 

             

Figure 9.22 Enable no-support areas (left), disable no-support areas (right) 

9.10 Toggle No-Support zones 

By clicking the “Toggle No-Support” command under the Support Generation menu, you can 

switch the display and hiding of the unsupported areas of all the parts on the platform. 

9.11 Remove No-Support zones 

Remove all No-Support Zones 
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If no-support zones are added to the part, clicking “Remove All” command, all no-support zones 

on the part will be removed. 

Remove Marked No-Support Zones 

Firstly, mark one or more added no-support zones on the part, then clicking “Remove Marked” 

command, the marked no-support zones on the part will be removed. 

Pick and Remove No-support Zones 

Firstly, use the mouse to select a continuous no-support zones on the part, then clicking “Pick 

Remove” command, the selected no-support zones on the part will be removed. 
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10 Analysis  

 

Figure 10.1 Analysis menu 

10.1 Collision Detection 

After clicking the “Collision Detection” command in the Analysis menu, or pressing the shortcut 

keys Shift + K, A collision detection dialog will pop up, as shown in Figure 10.2. 

 

Figure 10.2 Collision Detection setting 

If "All parts" is selected, collision detection is performed on all parts on the platform. If "Selected 

parts" is selected, collision detection is performed only on the selected parts. 

Grid size: Determines the grid for checking collisions. The finer the grid, the more time the 

calculate takes. 

Check with clearance: Define the spacing allowed between parts. If they are located within a 

distance smaller than this value, they will be identified as colliding parts.  

After clicking “Update” button, the corresponding result will be displayed on the dialog according 

to whether there is a collision, as shown in Figure 10.3. Besides, in the display window, you can 

perform operations such as moving, rotating, and indicate plane to the selected parts. The 

collision detection will be performed again after each operation on the part. 
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Figure 10.3 Collision Detection effect 

10.2 Wall Thickness Analysis 

Wall thickness analysis operation helps to detect small details, thin/thick walls, which is helpful 

for predicting where problems can pop up during building. This module can determine the local 

wall thickness for each triangle. If requested, you can divide bigger triangles in smaller ones 

according to the refine triangles parameters entered. This way, a more detailed figure of the wall 

thickness can be calculated. After clicking the “Wall Thickness” command under the Analysis 

menu, or the shortcut key Shift + W, the “Wall Thickness Analysis” dialog will pop up in the display 

window, as shown in Figure 10.4. 



131 

 

 

Figure 10.4 Wall Thickness Analysis setting 

There are two display results for wall thickness analysis, Marking and Gradient coloring. The 

corresponding parameters are explained in Table 10.1. 

Table 10.1 Parameter settings 

Minimum thickness Define the minimum wall thickness required. Every 

triangle with a local wall thickness smaller than the 

entered value, will receive the red color.  

Maximum thickness The maximum thickness is the wall thickness which 

you no longer expected to have problems. The local 

thickness bigger than the maximum thickness does 

not require special attention and will be marked as 

the yellow color. 

Triangles with local thickness situated between the 

minimum and the maximum thickness will have a 

color gradually changing from the red color 

(minimum) to the yellow color (maximum wall 

thickness) over the color spectrum. The minimum 

and maximum wall thickness also forms the 

borders of the Wall Thickness Color Legend 

Refine triangles If checked, the triangles that met the criteria are 

re-triangulated. The analysis is based on the newly 

created triangles. 
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Number of iterations The number of iterations of the triangles that are 

re-triangulated. 

The min edge length The minimum edge length of the triangles after re-

triangulation. 

10.2.1 Marking 

For the marking display mode, after setting the parameters and analyzing the part, a list is 

displayed, which contains the areas that match the set conditions, as shown in Figure 10.5. The 

view will shrink to a specific triangle area on the part when clicking on an item. 

 

Figure 10.5 Marking area list 

10.2.2 Gradient coloring 

In the gradient coloring display mode, after setting the parameters, click “Apply” button to 

display the analyzed color legend, different wall thicknesses correspond to different colors, as 

shown in Figure 10.6. 
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Figure 10.6 Color legend 

10.3 Trapped Volumes 

Because the height difference between the resin in the cavity and the part will cause the part to 

deform during the manufacturing process, the user usually needs to determine whether there is 

a cavity in the part before manufacturing the part. 

This function makes it easy to detect the cavity on the part, and once these areas are detected, 

some perforator operations can be done to avoid part deformation, or to reposition the part to 

minimize the cavity. 

There are two types of trapped volumes that can be detected on your part, which are open 

volumes and closed volumes. 

Open trapped volumes: there is a hole in the cavity in the part, and after the manufacture is 

completed, the resin in the cavity flows out through the hole. 

Closed volumes: the cavity exists inside the part and has no connection with the outside world. 

The resin in the cavity cannot be discharged after manufacture. 
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After selecting one or more parts on the platform, click the “Trapped Volumes” command 

under the Analysis menu, the Detect Trapped Volume parameter setting dialog will pop up in the 

display window, as shown in Figure 10.7. 

 

Figure 10.7 Detect trapped volumes setting 

The corresponding parameters in the settings dialog are explained in Table 10.2. 

Table 10.2 Parameter settings 

Accuracy 
The higher the accuracy, the longer the analysis time. The software 

offers low, medium and high precision options. 

Customize grid step 
If checked, perform analysis based on predefined or entered grid 

sizes. 

Skip volumes small than Eliminate cavities detection with volume less than the input value. 

Analyze The analysis of the trapped volumes is performed. 

After setting the parameters, click “Analyze” button, the detection analysis report will pop up at 

the bottom of the dialog, as shown in Figure 10.8. 
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Figure 10.8 Trapped volume analysis report 

The corresponding parameters in the report are explained in Table 10.3. 

Table 10.3 Trapped volume analysis report parameters 

Visibility 
Check the check-box  to control whether the cavity in the part 

is visible and the default is checked. 

ID Each detected cavity has a unique ID identifier. 

Part Name Show part name. 

Volume The volume of the cavity detected. 

Type The type of the cavity detected. 

Auto zoom 
Automatically zoom to the selected cavity position, and the 

default is checked. 

Transparent part 
After checking, the part is in transparent state and the default is 

checked. 

10.4 Measurement 

After selecting any part, and clicking the “Measure” command in the Analysis menu, or pressing 

the shortcut keys Shift + M, you will enter the measurement mode. Measurement parameters 

settings dialog will pop up, including four sub-pages of Information, Distance, Angle, and Radius, 

which provides a variety of measurements for the part. 
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10.4.1 Information 

The Information page is used to measure the coordinate information of the basic graphic 

elements of the part, including points, lines, and triangles, as shown in Figure 10.9. The following 

three measurement options are available in the drop-down selection box:  

(1) Point: Move the mouse to any vertex of any mesh on the graph. The vertex will be marked by 

a red circle and the XYZ coordinate information of the point will be displayed in the Info field of 

the page. 

(2) Line: Move the mouse to any edge of the graph. The edge will be marked red, and the 

coordinate information of the two endpoints will be displayed in the Info field. 

(3) Triangle: Move the mouse to any triangular area on the graph. The two faces of the triangle 

will be marked red, and the coordinate information of the three vertices will be displayed in the 

Info field. 

 

Figure 10.9 Information page and basic measurement 

10.4.2 Distance 

The distance page is used to measure distance information, and a second feature menu is added 

in the distance tab, as shown in Figure 10.10. Two feature menus provide a variety of distance 

types: 



137 

 

(1) Point to point: Measure the distance between two points. Clicks two vertices in turn, and the 

measurement distance will be displayed in the Info field and on the graph simultaneously.  

(2) Point to line: Measure the distance from a point to a line. Clicks the vertex and the edge in 

order, and the measured distance will be displayed in the Info field and on the graph 

simultaneously. 

(3) Point to triangle: Measure the distance from a point to a triangle. Clicks the vertex and the 

triangle in order, and the measured distance will be displayed in the Info field and on the graph 

simultaneously. 

(4) Point to axis: Measure the distance from a point to the X axis, Y axis, or Z axis. Clicks a point 

on the part, and the measured distance will be displayed in the Info field and on the graph 

simultaneously. 

(5) Point to the plane: Measure the distance from a point to the X-Y, X-Z, or Y-Z plane. Clicks a 

point on the part, and the measured distance will be displayed in the Info field and on the graph 

simultaneously. 

(6) Line to line: Measure the distance between two lines. Clicks the two lines in turn, and the 

measured distance will be displayed in the Info field and on the graph simultaneously. 

(7) Line to plane: Measure the distance from the line to the parallel plane. Clicks the line and the 

parallel plane, and the measured distance will be displayed in the Info field and on the graph 

simultaneously. 

(8) Plane to plane: Measure the distance between two parallel planes. Clicks the two parallel 

faces, and the measured distance will be displayed in the Info field and on the graph 

simultaneously. 

(9) Thickness: Measure the thickness of a plane. Clicks any point on the measured plane, and the 

measured thickness will be displayed in the Info field and on the graph simultaneously.  
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Figure 10.10 Distance page and the distance measurement 

(10) 3D_view：European distance in three-dimensional space. 

(11) 2D_XY：The distance parallel to the X-Y plane. 

(12) 2D_XZ：The distance parallel to the X-Z plane. 

(13) 2D_YZ：The distance parallel to the Y-Z plane. 

(14) 1D_X：The distance parallel to the direction of the X axis. 

(15) 1D_Y：The distance parallel to the direction of the Y axis. 

(16) 1D_Z：The distance parallel to the direction of the Z axis. 

10.4.3 Angle 

The Angle page is used to measure angle information, and a second feature menu is added in the 

angle tab, as shown in Figure 10.11. The two feature menus provide a variety of angle 

measurement types: 

(1) 3 Points: Clicks the three vertices in turn, and then you can measure the angle with the second 

vertex as the center. The angle information will be displayed in the Info field and on the graph 

simultaneously.  
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(2) Line to line: Clicks the two lines in turn, and then you can measure the intersection angle of 

the two lines. The angle information will be displayed in the Info field and on the graph 

simultaneously.  

(3) Line to plane: Clicks on the line and the non-parallel plane, and then you can measure the 

intersection angle between the line and the non-parallel plane. The angle information will be 

displayed in the Info field and on the graph simultaneously.  

(4) Line to axis: Measure the intersection angle between the line and the X axis, Y axis, or Z axis. 

Clicks on a line on the part, the angle information will be displayed in the Info field and on the 

graph simultaneously.  

(5) Line to plane: Measure the intersection angle between the line and the X-Y, X-Z, or Y-Z plane. 

Clicks on a line on the part, the angle information will be displayed in the Info field and on the 

graph simultaneously.  

(6) Plane to plane: Clicks the two triangular facets in turn, and then you can measure the 

intersection angle of the two faces. The angle information will be displayed in the Info field and 

on the parts simultaneously.  

(7) Plane to axis: Measure the intersection angle between the plane and the X axis, Y axis, or Z 

axis. Clicks on a plane on the part, the angle information will be displayed in the Info field and on 

the graph simultaneously.  

(8) Plane to plane: Measure the intersection angle between the plane and the X-Y, X-Z, or Y-Z 

plane. Clicks on a plane on the part, the angle information will be displayed in the Info field and 

on the graph simultaneously.  
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Figure 10.11 Angle page and angle measurement 

(9) 3D_view：The angle in three-dimensional space. 

(10) 2D_XY：The angle parallel to the X-Y plane. 

(11) 2D_XZ：The angle parallel to the X-Z plane. 

(12) 2D_YZ：The angle parallel to the Y-Z plane. 

10.4.4 Radius 

The Radius page is used to measure the radius of a selected circle or an arc, as shown in Figure 

10.12. The following two measurement options are available in the drop-down selection box:  

(1) 3 Points: Click three vertices which are not collinear in turn, and the three vertices will 

determine a circle. The circle with its center will show on the graph, and the radius information 

will be displayed in the Info field and on the graph simultaneously.  

(2) Circle:  In the show Part Boundary mode, click any circle or arc on the boundary lines of the 

part. The circle with its center will show on the graph, and the radius information will be displayed 

in the Info field and on the graph simultaneously. 
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Figure 10.12 Radius page and radius measurement 

If you need to measure for multiple times, you can clear the existing measurement data in the 

Info field and the marks on the part by clicking the “Clear Measure” button at the bottom of the 

dialog.  

10.5 Slices Distribution 

Click the “Slice Distribution” command in the Analysis menu, and the slice area distribution map 

of all parts will appear, as shown in Figure 10.13. The slice distribution graph gives you the 

possibility to analyze the surface area for each layer and the distribution within the platform. 
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Figure 10.13 Slice distribution graph 

Some operations can change the covered area, such as moving, rotating parts, and so on. In this 

case, you need to click the "Update" button to recalculate. 

10.6 Volume Estimation 

Show the volume estimation of non-solid support. To calculate the volume estimate, you need 

to set the laser parameters of the platform attributes in the Platform Definition firstly (for 

parameter settings, see Chapter 12.2). After clicking the “Volume Estimation” command under 

the Analysis menu, a message prompt box will pop up, as shown in Figure 10.14. Click 

“Parameters” button to directly go to laser parameters setting dialog. Click OK to close the dialog. 

And the volume estimation for selected parts and supports will be displayed in the lower right 

corner of the interface window. 
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Figure 10.14 Message prompt dialog 

10.7 Cost Estimation 

Show the cost estimation of the materials consumed for printing part(s). To calculate the cost 

estimation, you need to set the unit cost price, material density and currency in the Platform 

Definition firstly (for parameter settings, see Chapter 12.2). After clicking the “Cost Estimation” 

command under the Analysis menu, a message prompt box will pop up, as shown in Figure 10.15. 

Click Parameters button to directly go to cost parameters setting dialog. Click OK to close the 

dialog. And the cost estimation for all parts will be displayed in the lower right corner of the 

interface window, and the cost estimation for each part will be displayed beside each part name 

in the Parts List. 

 

Figure 10.15 Message prompt dialog 

10.8 Build Time Estimation 

Show an estimation of the build time of the part(s). To calculate the time estimation, you need 

to set the laser parameters and build parameters of the platform attributes in the Platform 

Definition firstly (Parameter setting see chapter 13.4). After clicking the “Build Time Estimation” 

command under the Analysis menu, a message prompt box will pop up, as shown in Figure 10.16. 

Click Parameters button to directly go to laser parameters and build parameters setting dialog. 

Click OK to close the dialog. And the total build time estimation for all parts will be displayed in 

the lower right corner of the interface window. 
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Figure 10.16 Message prompt box 
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11 Slice 

Select the part, and click the “Slice” command in the Home menu. A dialog box for slice operation 

will pop up in the interface window, as shown in Figure 11.1. 

 

Figure 11.1 Slice operation setting 

If "All Parts" is selected, all parts on the platform will be sliced. If "Selected Parts" is selected, 

only selected parts will be sliced. Set the slice layer thickness and beam compensation 

according to the characteristics of the machine. If you select the "Export slice files" check box, 

you can export the slice file to a local folder. 

After setting the parameters, click the "Start" button to slice the file, and you can enter the slice 

window, or you can click the " " icon button on the sidebar to enter the slice window, as 

shown in Figure 11.2, the slice file is added to slice list on the left side. The slicing mode also 

provides zooming operations, as well as controlling the display or hiding of grids, platforms, 

rulers, and coordinate systems. 
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Figure 11.2 Slice window 

The Layers field displays the detailed information for the selected slice file, including Dimensions 

and Layer information. The right scroll bar is used to change the Z-axis coordinate to observe 

different layers, and the information of the current layer is displayed in the Layer Information 

field, including Layer, Total, Z current, Z max, Contours, and Area. 

In the Slice menu, click the "Show 3D" command to switch between 2D and 3D views. In the 3D 

view, if you check the "Show All" selection box, you can observe the whole part in the sliced state. 

If you check the "Solid View" selection box, you can observe the solid view of each slice layer to 

better distinguish it from the supported slice layer. Moreover, the Z-axis coordinates of the 

current slice and the two-dimensional (X-Y) coordinates of the cursor position is shown at the 

bottom of the display window. 

Move Slices: 
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Select the slices, and click the "Move" command on the menu. A dialog for moving the slices will 

pop up, as shown in Figure 11.3.  

 

Figure 11.3 Move slices setting 

Set the distance to move and whether you need to duplicate this slice, then click the “Apply” 

button. 

Rotate Slices: 

Select the slices, and click the "Rotate" command on the menu. A dialog for rotating the slices 

will pop up, as shown in Figure 11.4.  

 

Figure 11.4 Rotate slices setting 

Set the rotation angle, rotation center, and whether you want to copy this slice, then click the 

"Apply" button. 
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Scale Slices: 

Select the slices, and click the "Scale" command on the menu. A dialog for scaling the slices will 

pop up, as shown in Figure 11.5.  

 

Figure 11.5 Scale slices setting 

Set the zoom factor, zoom center, and whether you want to copy this slice, click the “Apply” 

button. 

Mirror Slices: 

Select the slices, and click the "Mirror" command on the menu. A dialog for mirroring the slices 

will pop up, as shown in Figure 11.6.  

 

Figure 11.6 Mirror slices setting 
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Set the mirror plane, plane position, and whether you want to copy this slice, click the "Apply" 

button. 

Duplicate Slices: 

Select the slices, and click the "Duplicate" command on the menu. A dialog for duplicate slices 

will pop up, as shown in Figure 11.7.  

 

Figure 11.7 Duplicate slices setting 

Set the copy number, gaps, and whether you need to fit the platform, click the "OK" button. 

Offset Slices: 

Select the slices, and click the "Create Offset" command on the menu. A dialog for offset slices 

will pop up, as shown in Figure 11.8.  

 

Figure 11.8 Offset slices setting 
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If "All slices" is selected, all slices on the platform will be offset. If "Selected slices" is selected, 

only selected slices will be offset. Then set the offset distance and method (inside or outside), 

click the "OK" button, a new slice path parallel to the original slice path and offset by a certain 

distance will be generated.  

Create Hatch: 

Select the slice, and click the "Create Hatch" command on the menu. A dialog box for creating 

hatch will pop up, as shown in Figure 11.9. 

 

Figure 11.9 Hatch slices setting 

Parameter introduction is shown in Table 11.1 

Table 11.1 Parameters explanation 
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In Skin, 

Up Skin, 

Down 

Skin、Z 

Connect 

Skin, 

Hole/Slot 

Skin 

Border 

parameters 

Beam 

compensation 

Set the beam compensation value for the slice border line 

Offset number Define the number of offset borders, enter "1" to generate 
a border, enter "2" to generate two borders, and so on 

Offset Space Distance between two adjacent borders 

Border order From inner border to outer border, or from outer border 

to inner border 

Hatch 

parameters 

Hatch distance Distance between two adjacent hatch lines 

Border space Distance from hatch line to innermost border 

Rotate start 

angle 

The hatch line of each layer can be rotated at a set 
incremental rotation angle, and the starting angle defines 
the initial rotation angle 

 

Rotate 
increment 
angle 

Defines the rotation angle increment of each layer, for 
example, enter "45", which means that the rotation angle 
of each layer increases by 45 degrees 

 

Hatch style Define the hatch style 

Single fill: Generates a parallel straight scan path 

Offset fill: Generates an offset closed contour scan path 

starting from the border 

Cross fill: Generates straight scan paths that are 

perpendicular to each other 
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Stripe fill: Generate stripe hatch, gap can be set between 

stripes 

Chess fill: Generates chess hatch, gap can be set between 

each rectangular area 

   

Single fill                           Offset fill 

   

Cross fill                            Stripe fill  
    

 

 

 

 

 

 

 

 

 

     

 

Chess fill 

Hatch sorting Two type, zigzag fill (no jump) and block sorting (jump) 
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      Zigzag (no jump)                   block sorting (jump) 

Hatch connect Defines whether single path with hatch lines end to end 

(only valid for block sorting jump mode) 

Up Skin, 

Down Skin 

 Skin number Define the number of layers on the upper and lower 

surfaces, for example, enter "3" to start from the lower 

surface. The overlapping area of the three layers above is 

the lower surface 

 
Skin angle Define the recognition angle of the upper and lower 

surfaces. When the surface slope angle is less than the set 

value, the upper and lower surfaces are recognized. 

Z Connect 

Skin  

 Area factor The area of the connection area / the area of the current 

layer (The Z connection area refers to the connection area 

(overlapping part) of the current layer and the previous 

layer. If the area ratio is less than the set value, it is the Z 

connection area, and then the upper and lower N layers 

corresponding to the identified connection area are also as 

Z Connection area.) 

Upper number When the area change ratio of the upper and lower layers 

is less than the set value (the default is 0, 1), the current 

layer is the Z-axis joint connection layer. The number of 

upper recognition layers defines the number of layers in 

the plane of the N corresponding layers up to the current 

connected layer. 

Lower number The number of recognition layers on the lower surface 

defines the number of layers in the plane of the N 

corresponding layers down to the current connected layer. 

Hole/Slot 

Skin 

 Gap width Defines the threshold for identifying the gap in holes and 

slot, in mm. When the diameter of the hole or the 

maximum gap width of the slot is smaller than this value, it 

is identified as a slot. For example, if the gap width is set to 
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In the "Hatch Slices" dialog, click the " " icon button to add a new hatch script, click " " to 

set the default hatch script, and export / import the parameter file of the hatch script 

Clear Hatch: 

Select the slices with hatch, and click the "Clear Hatch" command on the menu, the hatch in the 

slice will be cleared. 

Z Compensation: 

Select the slices, and click the "Compensation Z" command on the menu. The Z-compensation 

dialog will pop up, as shown in Figure 11.10. 

 

Figure 11.10 Z-Compensation setting 

If "All slices" is selected, Z-compensation will be performed on all slices on the platform. If 

"Selected slices" is selected, Z-compensation will only be performed on the selected slices. Then 

set the Z-compensation distance, and click the "OK" button. 

Point Reduction: 

1.0mm, a hole with a diameter less than 1.0mm is 

identified as a hole feature, and the maximum gap width 

of the slot is less than 1.0mm is identified as a slot feature. 

 
Hatch range Define the extended range of the generated fill path for 

holes 
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Select the slice, and click the "Point Reduction" command on the menu. A dialog box for 

reducing points will pop up, as shown in Figure 11.11. 

 

Figure 11.11 Reduce point setting 

If "All slices" is selected, the point reduction is performed on all slices on the platform. If 

"Selected slices" is selected, the point reduction is performed only on the selected slices. Then 

set the maximum deformation value, and click the "OK" button. This operation reduces the 

amount of points needed to maintain the original shape while adhering to a specifiable 

tolerance of deformation. Be mindful not to specify too large a value for the maximum 

deformation as this may impair the quality of rounded contours to unacceptable levels. 

Unite Slices: 

Select the slice, and click the "Unite Slices" command on the menu. A Slices union dialog will 

pop up, as shown in Figure 11.12 

 

Figure 11.12 Slices union setting 
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If "All slices" is selected, the union operation is performed on all slices on the platform. If 

"Selected slices" is selected, only the selected slices will be union. Then set the union type, and 

click the "OK" button. 

There are two union type. The first type, "Unite each slice separately," is to remove the self-

intersecting part of each slice file. As shown in Figure 11.13, the second type, "Unite all the 

slices into one" is to merge two or more slice files into one file, and also remove the self-

intersecting part. 

           

Figure 11.13 Unite one slice 

Intersect Slices: 

Select two or more slices, and click the "Intersect Slice" command on the menu. Only the 

common area of all selected slices is retained. 

Export Slices: 

Select the slice, and click the "Export Slices" command on the menu. A dialog for exporting the 

slice file will pop up, as shown in Figure 11.14. 
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Figure 11.14 Export slice setting 

If "All slices" is selected, all the slices on the platform will be exported, if "Select slices" is 

selected, only the selected slices will be exported. Then set the export format, the related 

parameter settings of this format, and the exported file path, and click the "OK" button. 
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12 Setting 

12.1 Option Setting 

Click the "Options" command under the File menu or the " " icon button on the sidebar, and 

the option setting dialog will pop up, as shown in Figure 12.1. 

 

Figure 12.1 Options setting 

General setting: 

1）Language 

The currently supported languages include Chinese, English, Japanese, German, Spanish, and 

Korean. 

2）Unit Size 

The imported part looks too small or too large, and a dialog box asks if you want to convert 

units.  

3）Display Options 
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OpenGL anti-aliasing: The smooth edge of the part brings better visual effects. 

Show platform on default: Set whether to display the platform after launching the software. 

Show recoater on default: Set whether to display the recoater after launching the software. 

Show ruler on default: Set whether to display the ruler after launching the software. 

Show coordinate system on default: Set whether to display the coordinate system after 

launching the software. 

Show orientation cube on default: Set whether to display the orientation cube after launching 

the software. 

Show orientation indicator on default: Set whether to display the orientation indicator after 

launching the software. 

Show part dimension on default: Set whether to display the part dimension after launching the 

software. 

Show combined bounding box on default: Set whether to display the combined bounding box 

after launching the software. 

Show random color on default: Set whether to display the random color after launching the 

software. 

Show slicing grid on default: Set whether to display the slicing grid after launching the software. 

Rename setting: 

In the Options dialog, click the Renaming option on the left, and the page for setting the 

rename function will open, as shown in Figure 12.2. 

 

Figure 12.2 Rename setting 
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After performing repairing, labeling, z-compensation, scaling, mirroring, hollowing, duplication, 

cutting and perforation on the original part, a new part or several new parts will be created, such 

as “part1_repair” and “part2(hollowed)”. The renaming format of the new created part(s) can be 

set here. Double clicked on a function in the list that needs a change (such as Repair Parts) in its 

renaming style, an editing dialog appears for users to choose from the predefined renaming or 

to design custom templates, as shown in Figure 12.3. You can insert what will be added before 

or after the part name in the text fields left and right of “part name”. Below, you can see a 

preview of how your parts will be named. "Part name" always refers to the name of the original 

part. After all the input, click the “ ” icon on the right of Preview so that the custom design will 

be added to the predefined templates to choose from. With the button "Set to defaults" at the 

bottom of the dialog, you can restore the default predefined naming for that particular function.  

 

Figure 12.3 Rename format edit setting 

After setting the naming format of these functions, double-click " Reset default settings by 

double click" to restore the default naming format of all functions. 

Color Setting: 

In the Options dialog, click the Color option on the left, you can open the page for setting the 

color of parts, slices, and some objects in repair and support, as shown in Figure 12.4. 
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Figure 12.4 Color setting 

The color dialog provides the entire spectrum of each color, as shown in Figure 12.5. 

 

Figure 12.5 Select color 

In addition, for part and slice, you can also change the color in the displayed color dialog by 

double-clicking the color icon  on the right side of the part or on the left side of the slice.  

Customize UI Setting: 
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In the Options dialog, click the Customize UI option on the left, you can open page for setting 

the user interface, as shown in Figure 12.6. Users can customize shortcut keys, ribbons, 

toolbars, and right-click menus if need. 

 

Figure 12.6 Customize UI setting 

The corresponding function parameters in the dialog are explained in Table 12.1. 

Table 12.1 Interface function 
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Workspace 

 

Different interface modes defines their own toolbars and context menus. 

The basic commands are to set shortcut keys for the function without the 

corresponding toolbar command. 

Commands A list of all commands in Voxeldance Additive. If a command has the keyboard 

shortcuts, it is shown next to the command. Scroll through the list, or use the 

search box to find a specific command 

 Search box for the Commands.  

Keyboard shortcuts 

To assign or delete a keyboard shortcut, double-click the shortcut area and 

enter or delete the shortcut. 

 

Ribbon The ribbon tab contains all the ribbons and their available functions. The 

visible ribbons and functions have a check. 

Different interface mode corresponds to different default toolbars. 

Toolbars The toolbar tab contains all the toolbars and their available functions. The 

visible toolbars and functions have a check. 

Different interface mode corresponds to different default toolbars. 

Context Menus The context menu tab contains all context menus and their commands. 

Different interface mode corresponds to different context menus. 

 
Restores the default settings of the ribbon, toolbar, and right-click menu. 

1) Ribbon: 
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In Voxeldance Additive，users can customize the ribbon according to their needs. At present, 

there are default ribbon and custom ribbon. The default ribbon cannot be deleted or renamed, 

but the custom ribbon can be added, named and deleted by the user. 

Take the main interface mode as an example, as shown in Figure 12.7, the corresponding 

commands in the ribbon can be operated by clicking the function button below, or by the right-

click menus of the page, the group or a command.  

 

Figure 12.7 Ribbon setting 

To create a custom ribbon, proceed as Table 12.3. 

Table 12.3 Create a custom ribbon 



165 

 

1. 

After selecting the workspace where the page needs to be added, select 

a page in the ribbon tab and then click  or 

 to add a new page. 

2. 

Enter a name for the new page. 

 

3. Click  to add a new group。 

4. 

Enter a name for the new group. 

 

5. 

Select the command on the left and drag it to the new group to add the 

command. 

A separator can be added between the added group commands. 

6. 
Click “Save” to finish the creation of the ribbon. 

The new ribbon is visible in the selected interface mode. 

 

2) Toolbars： 

In Voxeldance Additive，users can customize the toolbars as required. Currently, there are 

default toolbars and custom toolbars. The default toolbar cannot be deleted or renamed, but 

the custom toolbar can be added, named, and deleted by the user. 

Take the main interface mode as an example, as shown in Figure 13.6, the corresponding 

commands in the toolbar tab can be operated by clicking the function button below, or by the 

right-click menus of the toolbar or a command. 
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Figure 12.8 Toolbars setting 

To create a custom toolbar, proceed as Table 12.4. 

Table 12.4 Create a custom toolbar 

1. 

After selecting the workspace where the toolbar needs to be added, 

select a toolbar in the toolbar tab and then click  or 

 to add a new toolbar. 

2. 
Enter a name for the new toolbar. 
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3. 

Add commands by selecting the command in the left side and dragging it 

to the new toolbar. 

By adding a separator, you can make different groups within your toolbar. 

4. 

Click “Save” to finish the creation. 

The new toolbar is visible in the selected interface mode, and dragging 

the toolbar can change its position. 

 

3) Context Menus： 

In Voxeldance Additive，the user can customize the context menus as required. Currently, there 

are default context menu and custom context menu. Users cannot delete or rename the default 

menu, but can delete or add a command in the default menu. The custom context menus are 

created, named, and defined by the user and can be deleted. 

Take the main interface mode as an example, as shown in Figure 12.9, the corresponding 

commands in the context menu tab can be operated by clicking the function button below, or by 

the right-click menus of the context menu or a command.  
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Figure 12.9 Context menus setting 

To create a custom context menu, proceed as Table 12.5. 

Table 12.5 Create a custom context menu 

1. 

After selecting the workspace where the context menu needs to be 

added, select a context menu in the context menu tab and then click 

 or  to add a new context menu. 

2. 

Enter the name and the specified shortcut key for the new context 

menu. 
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3. 

Add commands by selecting the command in the left side and dragging 

it to the new context menu. 

You can add menu groups, separators in the context menu commands. 

4. 

Click “Save” to finish creating the creation. 

The method of the new context menu is visible in the selected interface 

mode: press the specified shortcut key with clicking on the right mouse 

button, then the pop-up menu is the new context menu. 

 

12.2 Platform Setting 

In the Home menu, click the “Create Platform - Create Platform” command to create a new 

default platform. Click the “Create Platform - Platform Definition” command to open the 

platform settings dialog, as shown in Figure 12.10. 

 

Figure 12.10 Platform setting 
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1) In the "My Machines" dialog, click the " " icon button, you can change the 3D dimensions 

of the platform by adjusting the X, Y, and Z values. With check "Enable Unworkable Area 

Recognition", you can set some areas on the platform where parts cannot be placed. Click "Edit 

Unworkable Area Parameters", a dialog box for setting the unworkable area will pop up, as 

shown in Figure 12.11. 

 

Figure 12.11 Unworkable area setting 

Click the "Create" button, you can create and edit a circular or polygonal unworkable area, as 

shown in Figure 12.12. The unworkable areas of circle and polygon can be defined by setting 

their respective parameter values. Besides, if "Enable 3D unworkable area" is checked, the Z-

axis height of the unworkable area is defined by setting the height Z. Clicking "OK" will save this 

unworkable area and list it on the left. Clicking the "Delete" button will delete the unworkable 

area selected on the left list. 
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Figure 12.12 Edit unworkable area 

The set unworkable areas are marked in red on the platform, and the effect is shown in Figure 

12.13. 
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Figure 12.13 Platform with unworkable area 

2) In the "My Device" dialog, click the " " icon button, and the setting page of the platform 

attributes will pop up, as shown in Figure 12.14. 

 

Figure 12.14 Platform attributes setting 

The detailed parameter explanation is shown in Table 12.8. 

Table 12.8 Platform parameters 

Best Boundary of platform Best Boundary in 2D and Best Boundary in 3D 

Margin to X side The distance between print area to border X 

Margin to Y side The distance between print area to border Y 

Margin to Z side 

The distance between print area to border Z (Visible when 

selecting “Best Boundary in 3D) 

Blade position Displayed blade direction position relative to the platform： 
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None: Do not show blade direction 

Front side of the platform：Blade direction is displayed in front 

of the platform 

Back side of the platform：Blade direction is displayed behind 

the platform 

Left side of the platform：Blade direction is displayed on the 

left side of the platform 

Right side of the platform：Blade direction is displayed on the 

right side of the platform 

Laser parameters  

Laser Power Laser intensity (mW) 

Laser Spot Diameter The diameter of the laser spot 

Build parameters  

Part parameters  

Scan speed Laser scanning speed 

Layer thickness Slice thickness 

Hatch distance Spacing distance when filling 

Recoat time 

The time required to coat a new resin/powder layer on an 

already made structure 

Support parameters  

Scan speed Laser scanning speed 

Layer thickness Slice thickness 

Hatch distance Spacing distance when filling 

Recoat time 

The time required to coat a new resin/powder layer on an 

already made structure 

Cost estimation  
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Cost/Unit Set the cost unit price of materials used (/liter, /kg, /g) 

Material density Set the density of the material used (g/𝑐𝑚3、kg/𝑚3) 

Currency 

Select the currency type that corresponds to the cost 

unit price 

3) In the "My Machines" dialog, click the "Add Group" button, you can create a group to place 

the added devices. Click the "Add Device" button, there will be some machine libraries provided 

by the manufacturer, as shown in Figure 12.15, you can select the required machine. You can 

also enter the machine name in the "Search" box to find it, or click the " " icon to filter by 

manufacturer and technology. Click "Create Custom Parameters", you can set the shape of the 

platform (rectangle or circle), as well as the size and unworkable area. 

 

Figure 12.15 Select and define machine 

4) In the "My Device" dialog, right-click the machine item, the menus of "Set Default", "Edit" 

and "Duplicate" will appear, as shown in Figure 12.16. 
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Figure 12.16 The context menu of machine 

If you select the "Set Default" item, this platform will be used as the default platform when 

creating a new platform. If you select the "Edit" item, you will go to the page for setting the 

platform size and unworkable area. If you select the "Duplicate" item, this platform will be 

copied and added to the current list. 
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